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Defining Master Items 
 
IITA operates one Item Master organization and this is called WII (WAREHOUSES IN IBADAN).  This 
organization is the reference point from which all other organizations receive the definition of their 
items. 
 
In IITA there are two types of items for which item templates have been created:  
 
1. IITA ORDINARY: This is an ordinary inventory item 
2. IITA SPECIAL:  This is a lot controlled inventory item requiring the specification of an 

expiration date 
 
The item templates are used to set most of the parameters for the item automatically to reduce the 
possibility of errors in creating the item. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To define Master Item 

main information  
 
Note: First select the 
Change Organization 
function and select the WII 
(WAREHOUSES IN 
IBADAN) organization 

Navigate to the Master 
Items window: 
 
Oracle Inventory> 
Items> Master Items 
 
 

1.1 Enter the Item code number in the Item field.  The 
item code should be an 8 digit number.  The item 
code should be defined using guidelines provided by 
the Materials Management and Shipping Unit.   
The current guidelines are: 
Central Store  1 + 7 digit code 
PPS   00 + 6 digit code 
Medical Unit  2 + 7 digit code 
International House 3 + 7 digit code 
Research Farm 4 + 7 digit code 
Computer Services 5 + 7 digit code 
You need to know the last item code used and create 
the next code as the next number in the sequence of 
codes i.e. if the last code was 00000267, the code 
you will use is 00000268.   

1.2 Enter a simple description for the item in the 
Description field (this description will be changed 
later). 

1.3 Select the appropriate Primary Unit of Measure from 
the list of values in the Primary Unit of Measure Field. 

1.4 Confirm that the Item Status is Active. 
1.5 Copy the appropriate template to the item (see the 

next transaction for details). 
 

2. To copy options from 
the Item Template. 

In the Master Items 
window, select Copy 
From in the Tools 
menu. 
 

2.1 In the Copy From window select either IITA SPECIAL  
(With Lot Control & Shelf Life Control or IITA 
ORDINARY (With no Lot Control) from the list of 
values button in the Template field. 

2.2 Click on the Done button 
2.3 Save your work.  
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TRANSACTION NATURE NAVIGATION TASKS 
Note: The template chosen will automatically fill most of 
the necessary fields in the Master Item window. 

3. To complete the 
options in the Master 
Items window. 

Master Items Window. 3.1 Select the Purchasing tab from the tabbed regions 
and enter a list price for the item in the List Price field 
(the default is 1, if you do not know the list price, you 
should leave this field with that value). 

3.2 The system defaults an encumbrance account of 
01.0000.0000.00000000.0000000 for the item – this 
must be changed to the correct encumbrance 
account for the item depending on the subinventory in 
which it will reside.   

 
The existing subinventory groups and their 
associated accounts are here listed: 

 
International house 01.9901.1123.000000000.0000000 
Computer Services 01.9902.1004.000000000.0000000 
Clinic 01.9903.1132.000000000.0000000 
Central Store 01.9904.1015.000000000.0000000 
PPS Stores 01.9905.1107.000000000.0000000 
RFU Store 01.9906.1093.000000000.0000000 
 
3.3 Select the General Planning tab from the tabbed 

regions 
3.4 Select Min-Max as the Inventory Planning Method. 
3.5 Select an appropriate item Planner for this item from 

the list of values accessible in the Planner field (e.g. 
PPSPLANNER). 

 
Please see the following list for the codes of all the 
current item planner codes: 
 

CO-PLANNER COMPUTER SERVICES PLANNER 
CS-PLANNER CENTRAL STORES PLANNER 
IH-PLANNER I-HOUSE PLANNER 
M-PLANNER MEDICAL UNIT PLANNER 
PPSPLANNER PPS PLANNER 
RF-PLANNER RESEARCH FARM PLANNER 
 
3.6 Confirm that the Buy option is selected in the Make or 

Buy field. 
3.7 Enter Min-Max minimum and maximum quantities in 

the Minimum and Maximum fields under the Min-Max 
Quantity section. 

3.8 In the Source section select Supplier in the Type field 
3.9 Save your work. 
 

4. To specify a Catalog 
for a Master Item. 

In the Master Item 
window, select Catalog

4.1 Select an appropriate Catalog Group from the list of 
values in the Catalog Group window (e.g. 
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TRANSACTION NATURE NAVIGATION TASKS 
from the Tools menu. HARDWARE) 

 
4.2 Fill all the required fields under the Value column in 

the Descriptive Elements section as applicable to the 
item being created (e.g. DESCRIPTION, TYPE, SIZE, 
MATERIAL, MAKE, etc) 

4.3 Enter an optional note if required 
4.4 Click on the Update Description button. 
4.5 Save your work. 
 

5. To assign a Master 
item to other 
organizations. 

In the Master Item 
window, choose 
Organization 
Assignment from the 
Tools menu to display 
the Organization 
Assignment window, 
which lists all 
organizations in addition 
to the Item Master 
Organization (WII). 

5.1 If you want the item enabled in specific organizations, 
check the Assigned option in front of each 
organization.  

5.2 To assign the item to all organizations, click the 
Assign All button at the bottom of the window. 
Attention:  All items should be assigned to at least 
two organizations, WII (the master) and IRO (IITA). 

5.3 Save your work. 
 
Note:  The item will exist only in the Item Master and the 
other organizations specified here. 
 

6. To set organization 
specific attributes for 
the Item (first for IRO – 
IITA) – required. 

Organization 
Assignment window. 

6.1 First choose the line corresponding to the IRO (IITA) 
organization. 

6.2 Click on the Org Attributes button at the bottom of the 
screen (this will bring up the Organization Item 
window). 

6.3 Select the Inventory tab and if necessary, change 
both the Lot Expiration (Shelf Life) Control and Lot 
Control to No Control. 

6.4 Select the General Planning tab and change the 
Inventory Planning Method to Not Planned, remove 
the Min-Max Minimum and Maximum quantities and 
change the Source type to Inventory.  Leave the 
Organization and Subinventory fields blank. 

6.5 Save your work and close the Organization Item 
window. 

 
7. To set the organization 

specific attributes for 
the Master Item (for 
any other inventory 
organizations). 

Organization 
Assignment window. 

7.1 Choose any other line corresponding to any other 
Organization and click on the Org Attributes button. 

7.2 Adjust only the Min-Max quantities in the General Tab 
region as appropriate (leave everything else alone). 

7.3 Save your work. 
7.4 Repeat this for as many organizations as you have 

assigned the item to and when you have finished this, 
close the Organization Assignment window. 
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To associate an item with a Manufacturer Part Number. 
You can do this from the Master Item window by choosing Manufacturer Part Numbers from the 
Tools menu or alternatively from the Manufacturer’s Part Numbers function from the main navigation 
menu. 
 
Note: You can assign the same item to multiple manufacturer part numbers. 
 
TRANSACTION NATURE NAVIGATION TASKS 
8. To associate an item 

with a Manufacturer 
Part Number in the 
Master Item Window. 

Select Manufacturer 
Part Numbers from the 
Tools menu. 
 

8.1 Select a Manufacturer name from Manufacturer field 
list of values.  If you cannot see the correct 
Manufacturer name from the list of values, you need 
to enter this information using the alternate method 
stated in the next transaction. 

8.2 Enter a part number under the Part field.   
8.3 Save your work and close the form. 
 

9. Alternate method to 
enter an item and its 
associated 
manufacturer part 
number from the 
Manufacturer’s Part 
Numbers function. 

Navigate to the 
Manufacturers window. 
 
Oracle Inventory> 
Items> Manufacturer’s 
Part Numbers>  
By Manufacturers 
This brings up the 

Manufacturers window. 

 

9.1 If the Manufacturer has been defined in the system, 
you will see the name in the list (arranged in 
alphabetic order).  You can then select the name and 
click on the Parts button, which brings up the 
Manufacturer Part Numbers window. 

9.2 If the Manufacturer has not yet been defined in the 
system, you have to add this manufacturer’s name.  
Select New from the File menu, enter a 3-character 
code for the Manufacturer and then enter a 
Description (which should be the Manufacturers full 
name).  You can now click on the Parts button for this 
new Manufacturer line, which brings up the 
Manufacturer Part Numbers window. 

9.3 Enter the Manufacturer part number. 
9.4 Select the Item for which the part number id being 

created from the Item field list of values 
9.5 Save your work. 
 

10. To define item 
relationships (if 
required). 

Navigate to the Item 
Relationships window: 
 
Oracle Inventory> 
Items>  
Item Relationships 

10.1 The Find Item Relationships window appears (this 
window could also have been accessed from the 
Tools menu in the Master Items window). 

10.2 Choose New to define a new relationship. 
10.3 You can also enter search criteria and choose Find to 

display existing item relationships. 
10.4 Select an item that represents the From part of the 

relationship. 
10.5 Select an item that represents the To part of the 

relationship. 
10.6 Select the Type of relationship between the items. 

Available options are: 
Related: The items are related in a non–specific way. 
Substitute: One item is a substitute for another. 
Please do not use any other option. 
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TRANSACTION NATURE NAVIGATION TASKS 
10.7 Indicate whether the relationship is Reciprocal. 

A substitute relationship is reciprocal if you can use 
the From item as a substitute for the To item and vice 
versa. 

10.8 Save your work and close all the forms. 
 

 
Defining Item Specific Conversions  
Some items have very special conversions e.g. a BOX of an item could correspond to 20 
KILOGRAMS.  These types of special, item specific conversions should be defined where applicable 
using the following steps (When standard conversions apply, you do not need to carry out these 
steps): 
 
TRANSACTION NATURE NAVIGATION TASKS 
11. To define a conversion 

for a specific item 
within a unit of 
measure class (Intra–
class). 

Navigate to the Unit of 
Measure Conversions 
window: 
 
Oracle Inventory> 
Setup>  Units of 
Measure> Conversions 

11.1 Select the Intra–class tabbed region. 
11.2 Select New from the File menu to create a new 

conversion 
11.3 Select the item for which you want to define a 

conversion from list of values in the item field  
11.4 Enter a unit of measure in the Source Unit field, or 

select it from the list of values. 
11.5 Enter the conversion factor by which the unit of 

measure is equivalent to the base unit of measure 
established for this class. 

11.6 For example, if one LB (this unit of measure) is 
equivalent to 16 OZ (base unit), the conversion factor 
is 16. 

11.7 Save your work. 
 

12. To define a conversion 
for a specific item 
between unit of 
measure classes 
(Inter–class). 

Navigate to the Unit of 
Measure Conversions 
window: 
 
Oracle Inventory> 
Setup>  
Units of Measure> 
Conversions 
 

12.1 Select the Inter–class tabbed region. 
12.2 Select New from the File menu to create a new 

conversion 
12.3 Select the item for which you want to define a 

conversion from list of values in the item field 
12.4 Select the destination base unit of measure of the 

class to which you are converting a unit of measure. 
12.5 Enter the conversion factor by which the source base 

unit is equivalent to the destination base unit.  For 
example, if one BOX (destination base unit) is 
equivalent to 10 EACH (source base unit), the 
conversion factor is 10. 

12.6 Save your work 
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Subinventory Transfer 
 
You can transfer material within your current organization between subinventories, or between two 
locators within the same subinventory.  It is required that transfers between subinventories be 
performed with Move Orders only as approval is required for this transaction. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To enter a 

subinventory transfer. 
 
Note: Select the 
Organization for which you 
want to perform the 
subinventory transfer 
using the Change 
Organization function e.g. 
WAREHOUSES IN 
IBADAN (WII). 
 

Navigate to the 
Subinventory Transfer 
window: 
 
Oracle Inventory>  
Transaction> 
Subinventory Transfer 
 

1.1 The Subinventory Transfer Window appears. 
1.2 Enter the date and time of entry for the transaction. 
1.3 Enter the transaction type as Backflush 

Replenishment. 
1.4 Optionally, enter a source for the transaction type as 

a reference. 
1.5 Ignore the Serial Triggered option. 
1.6 Click the Transaction Lines button, the inventory sub-

transfer window appears. 
1.7 Select an inventory item to transfer. 
1.8 Ignore the revision field. 
1.9 Enter the subinventories from and to which to transfer 

material. Enter the same subinventory in the Sub 
and To Sub fields to transfer material between 
locators. 

1.10 Enter the locators from and to which to transfer the 
item.  

1.11 Enter a lot number for the item if it is lot controlled. If 
you want to enter multiple lot numbers, complete the 
remaining steps, then choose the Lot/Serial button to 
display the Lot Entry window. 

1.12 Enter a unit of measure. This can be the primary unit 
of measure (the default) or any valid alternate unit of 
measure. If you enter an alternate unit of measure, 
Oracle Inventory issues the quantity you specify in 
this unit of measure. Oracle Inventory also converts 
the quantity to the primary unit of measure so that it 
can correctly update the on–hand quantity depending 
on the conversions. 

1.13 Enter the quantity of the inventory item to transfer, 
based on the unit of measure you specified. 

1.14 Optionally, enter a reason code for the transaction. 
1.15 Optionally, enter up to 240 characters of free text that 

describes the transaction in the Reference field. 
1.16 Save your work. 
 

2. To enter lot or serial 
number information. 

Subinventory Transfer 
window. 

2.1 Choose the Lot/Serial button and enter the proper 
quantities to the fields. 
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TRANSACTION NATURE NAVIGATION TASKS 
3. To view quantity 

available and quantity 
on hand values. 

Subinventory Transfer 
window. 

3.1 Review the following fields at the bottom of the 
window: 
� Available: Displays the quantity available to 

transfer, based on the unit of measure you 
specified. The available quantity is the quantity on 
hand less all reservations for the item. This amount 
could include the amount you have reserved if you 
enter a transaction source that has reservations 
against it. The available quantity includes 
reservations against current transaction source. 
The available quantity is specific to the, lot 
number, From subinventory, and From locator you 
specify for the transfer.  

� On hand: Displays the current on–hand quantity for 
the item, based on the unit of measure you 
specified. The on–hand quantity is specific to the 
revision, lot number, From subinventory, and From 
locator you specify for the transfer. 

 
4. To process the 

transaction. 
Subinventory Transfer 
window. 

4.1 Save your work. 
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Inter–Organization Transfers 
 
You can define multiple inventories, warehouses, and manufacturing facilities as distinct 
organizations. With Oracle Inventory you can perform inter–organization transfers as direct or 
intransit shipments. You can transfer one or more items in a single transaction. You can also transfer 
partial quantities of the same item to different subinventories and locators in a single transaction. The 
items you transfer must exist in both organizations. You can also transfer expense and asset items 
from one organization to another using intransit inventory. 
 
You would use inter-organization transfers for example, if you want to transfer items from 
WAREHOUSES IN IBADAN inventory organization to the WAREHOUSES IN ONNE inventory 
organization. This transaction can be used if required when the other stations go live. 
 
Inter-organization transfers will be done for only inventory movements, in this transaction, there will 
be no encumbrance control and no approval hierarchies can be used. 
 
Inter–Organization Transfers via Intransit Inventory 
You should transfer material to intransit inventory when transportation time is significant. When you 
perform the transfer transaction, you do not need to specify the delivery location. You only need to 
enter the subinventory you are shipping from, a shipment number, the freight information, and, 
depending on the inter–organization transfer charge that applies between the organizations, a 
percentage of the transaction value (i.e. the uplift code) or a discrete amount that Oracle Inventory 
uses to compute transfer charges. 
 
As the FOB point for IITA is set to Shipment, the destination organization owns the shipment when 
the shipping organization ships it, and while it is intransit. 
 
While your shipment is intransit, you can update shipping information such as the freight carrier or 
arrival date in the Maintain Shipments window.  At the time of shipment, you must define your 
receiving parameters for the destination organization. You can receive and deliver your shipment in a 
single transaction or you can receive and store your shipment at the receiving dock.  
 
The validity of a transfer transaction depends on the controls you have defined in both the shipping 
and destination organizations for the items you want to transfer. For example, you can transfer item A 
from organization X to organization Y, even though item A is under lot control only in organization X 
(you can specify the lot numbers for item A in organization X during the transfer transaction). You can 
also transfer item B from organization X to organization Y if item B is under lot control only in 
organization Y (you can specify lot numbers for item B in the destination organization when you 
perform the receiving transaction). 
 
Transferring Between Organizations 

You can transfer material from your current organization to another organization, or from your current 
organization to intransit inventory. Material in intransit inventory belongs to the organization identified 
by the FOB point. In the case of IITA, the FOB point is shipment, which means that the destination 
organization owns the shipment when it is shipped and while it is intransit.  
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TRANSACTION NATURE NAVIGATION TASKS 
1. To enter the 

information to perform 
a transfer between 
organizations. 

Navigate to the Inter–
organization Transfer 
window: 
 
Oracle Inventory> 
Transactions>  
Inter-organization 
Transfer 
  

1.1 Enter the date of entry for the transaction. 
1.2 Enter an organization to which to transfer the 

material. 
1.3 Enter a transaction type of Intransit Shipment.  
1.4 You can optionally enter the Source for the 

transaction. 
1.5 Do not click on the Serial Triggered option 
1.6 Enter a 6-digit number for the shipment in the 

Number field.  
1.7 Enter any other optional Shipment information – for 

example, you can choose a Freight carrier. 
 

2. To enter the items to 
transfer. 

Choose the Transaction 
Lines button from the 
Inter–organization 
Transfer window. 
 

2.1 Select an inventory item to transfer. You can transfer 
the same item more than once. For example, you can 
specify an item more than once to transfer partial 
quantities to different subinventories or stock locators. 

2.2 Enter a subinventory from which to transfer the 
material. 

2.3 Enter the subinventory to transfer the material to.  
2.4 Enter from and to locators (if required). 
2.5 Enter a lot number for the item. If you want to enter 

multiple lot numbers, complete the remaining steps, 
then choose the Lot/Serial button to display the Lot 
Entry window.  For receipt transactions, if you enter a 
lot number the date the lot expires will be displayed. 

2.6 Enter a unit of measure. This can be the primary unit 
of measure (the default) or any valid alternate unit of 
measure. If you enter an alternate unit of measure, 
Oracle Inventory issues the quantity you specify in 
this unit of measure. Oracle Inventory also converts 
the quantity to the primary unit of measure so that it 
can correctly update the on–hand quantity. 

2.7 Enter the quantity of the item to transfer in your 
selected UOM. 

2.8 Optionally enter a reason code for the transaction 
(e.g. MOVEMENT).  

2.9 You can also enter up to 240 characters of free text in 
the Reference field that describe the transaction. 

 
3. To enter internal 

transfer charges to 
assign to the To 
organization. 

Transaction Lines. 3.1 Enter the percent of the transaction value that 
represents the transfer charge (uplift percentage).  
Ignore the Transportation Cost and Account fields. 
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TRANSACTION NATURE NAVIGATION TASKS 
4. To view quantity 

available and quantity 
on hand values. 

Transaction Lines. 4.1 Review the following fields: 
Available: Displays the quantity available to transfer, 
based on the unit of measure you specified. The 
available quantity is the quantity on hand less all 
reservations for the item. This amount could include 
the amount you have reserved if you enter a 
transaction source that has reservations against it. 
The available quantity includes reservations against 
current transaction source. The available quantity is 
specific to the lot number, From subinventory, and 
From locator you specify for the transfer. 
 
On hand: Displays the current on–hand quantity for 
the item, based on the unit of measure you specified. 
The on–hand quantity is specific to the lot number, 
From subinventory, and From locator you specify for 
the transfer.  

 
5. To process the 

transaction. 
Transaction Lines. 5.1 Save your work. 

6. Receiving an Inter-
organization transfer. 

See the standard 
Purchase Order 
receiving process in the 
IITA Oracle Purchasing 
User Guide. 

6.1 The receiving organization can receive the items 
normally (i.e. as in the Purchase Order receiving 
process), to quickly find the receipt, the sending 
organization name should be selected as the 
supplier. 

 
7. What to do if the 

transfer does not reach 
its destination and has 
to return to the source. 

 7.1 First, the receiving transaction has to be completed in 
the destination organization. 

7.2 Then the item(s) must be transferred back to the 
source organization. 

7.3 Finally, the item(s) must be received back in the 
source organization. 
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Managing Shipments 
Use the Manage Shipments window to view and update inventory intransit shipment information. You 
can view a wide variety of information about an inventory intransit shipment, including any internal 
requisition information backing the intransit shipment. You can enter or change selected header 
information including packing slip and bill of lading numbers, the expected receipt date, the freight 
carrier, the ship–to location, and the number of containers. You can also enter or change some 
information at the shipment line level: the packing slip number, receipt routing, and reason code. 
 
TRANSACTION NATURE NAVIGATION TASKS 
8. To select shipments. 
 
Note: Use the Change 
Organization function to 
select the receiving 
organization. 
 

Navigate to the Find 
Intransit Shipments 
window: 
 
Oracle Purchasing> 
Receiving> Managing 
Shipments 
 

8.1 Enter any of the following as selection criteria: 
requisition line number, Supplier (sending 
organization), and/or shipment number (if known).  In 
the tabbed regions in the lower part of the screen, 
you can specify additional selection criteria for the 
item, and date ranges. 

8.2 Select the Find button to move to the Manage 
Shipments window. 

8.3 In this window Purchasing displays Shipment Header 
information for the first shipment that meets the 
criteria. Use the down arrow (i.e. �) on your 
keyboard to display information for subsequent 
shipments that meet your search criteria. 
Note: For inventory intransit shipments, you will see 
Shipment Lines information only when you view the 
shipments from within the receiving organization.   

8.4 You can maintain data only in the following Shipment 
Header fields: Expected Receipt Date, Bill of Lading, 
Freight Carrier, Packing Slip, Ship–to Location, 
Number of Containers, and Comments. 

8.5 In the Shipment Lines region, only the Packing Slip, 
Comments, Transaction Reason Code, and Receipt 
Routing are maintainable. 

8.6 Save your work. 
 
Optionally, you can enter the following Shipment 
information: 
 
8.7 Freight Carrier: The freight carrier for the transfer. 
8.8 Number of Containers: The number of containers in 

which the material is stored for the transfer. 
8.9 Expected Receipt Date: The date you expect to 

receive the material at the destination organization. 
You must enter a date equal to or later than the 
current date. Oracle Inventory uses this date for 
reporting purposes only. 
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Performing Miscellaneous Transactions 
 
With a miscellaneous transaction you can issue material to general ledger accounts in your 
organization.  You can also make manual adjustments to the general ledger by receiving material 
from one account to inventory, and then issuing that material from inventory to another account. You 
can use this feature to issue items to individuals, departments, or projects; or to issue damaged items 
to expense accounts such as scrap. You can perform the receipts for items that were acquired by 
means other than a purchase order from a supplier (e.g. donated items).  
 
Miscellaneous transactions will be used for material returns (MRR) and adjustments for missing or 
damaged items.  Transactions types to be used will be Account receipts (for MRR), and Account alias 
receipt/issue.  In the case of the MRR, the user must return the item with either the original MRI 
report or a reference to the MRI on which the item was collected (the MRI reference number). 
 
The following transaction types will be used: 
Donations and existent Inventory items created in the system late (i.e. after the system goes live on 
January 1, 2002): Account Alias Receipt 
Missing and Damaged items: Account Alias Issue 
Material Return/Receipt (MRR): Account Receipt 
 

TRANSACTION NATURE NAVIGATION TASKS 
1. To enter a 

miscellaneous 
transaction. 

 
Note: Use Change 
Organization to select the 
proper organization for the 
Transaction (e.g. WII - 
WAREHOUSES IN 
IBADAN) before selecting 
the Miscellaneous 
Transaction window. 

Navigate to the 
Miscellaneous 
Transaction window: 
 
Oracle Inventory> 
Transactions> 
Miscellaneous 
Transaction 
 

1.1 Enter the date and time of entry for the transaction. 
Otherwise system will select the current date and 
time. 

1.2 Select a miscellaneous transaction Type: 
� Use Account Receipt transaction type to transact 

MRR. 
� Use Account Alias Issue transaction type to 

transact the issuing of Missing/Damaged items. 
� Use Account Alias Receipt transaction type to 

introduce donated items into inventory. 
Note: In the case of MRR processing, the requestor 
should provide the reference number of MRI used to 
collect the items being returned. As it is possible to 
forget the number, the Requisition summary function 
can be used to obtain information on past internal 
requisitions (MRI), including accounts charged.  

1.3 Enter the source of the transaction Type as in the 
case of an Account Alias’s name e.g. 
INSURANCE_ACCOUNT.  

1.4 Enter the Account against which the material is 
chargeable.  If you selected the Account Alias 
Receipt/Issue, you cannot enter anything in this field, 
but if you selected Account Receipt, you must enter 
an account combination. 

1.5 Ignore the Serial Triggered option. 
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TRANSACTION NATURE NAVIGATION TASKS 
2. To enter the item to 

transfer. 
Choose Transaction 
Lines in the 
Miscellaneous 
Transaction window. 
 
The Transaction Lines 

Detail folder window 

appears. 

 

2.1 Select an inventory Item to issue or receive (from list 
of values) 

2.2 The item revision (Rev) should be ignored; this option 
is not applicable to IITA. 

2.3 Enter a subinventory code (from list of values) e.g. 21 
(for PPS). 

2.4 Enter a locator (from list of values) e.g. 21A-01A-01. 
You must enter a value here if you entered a 
subinventory code in the related field.  As all 
warehouses in IITA are locator controlled, the locator 
code is required for all inventory transactions. 
Note: When entering the information for the item to 
transfer, you will see the item description and 
available on-hand quantity at the bottom of the 
window.  As you continue to enter more detailed 
information about the item, the quantity available and 
quantity on-hand change depending on the 
warehouse and stock locator detail. You may see all 
the inventory quantities related with this item from the 
On-Hand Quantity inquiry screen. 

2.5 Optionally, enter a Lot Number and an Expiration 
date for the item lot.  
If you want to enter multiple lot numbers for the same 
item, complete the remaining steps then choose the 
Lot/Serial button to display the Lot Entry window. 

2.6 Confirm that the Unit Of Measure is appropriate for 
the transaction. This can be the primary unit of 
measure (the default) or any valid alternate unit of 
measure. If you enter an alternate unit of measure, 
Oracle Inventory issues the quantity you specify in 
this unit of measure. Oracle Inventory also converts 
the quantity to the primary unit of measure so that it 
can correctly update the on–hand quantity. 

2.7 Enter the quantity of the inventory item to issue or 
receive, based on the unit of measure you specified. 

2.8 Leave this field blank to use the system average cost 
at the time of the transaction. 

2.9 View the account that you entered in the header level 
for use in the transaction. 

2.10 Optionally, choose an appropriate reason (from list of 
values) code for the transaction. For example, 
RETURN (which is what you would use in the case of 
MRR transactions). 

2.11 Optionally, in the Reference field, enter up to 240 
characters of free text that describe the transaction.  
For MRR transactions, enter the MRI number. 

2.12 If you want to enter any additional lines, you can 
repeat the above process for each line. 
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TRANSACTION NATURE NAVIGATION TASKS 
2.13 Save your work to process the transaction.  When 

you save it, the line(s) your entered in the Transaction 
Lines window will disappear. 

2.14 Close the Transaction Lines window and then close 
the Miscellaneous Transaction Header window. 

 
3. To enter lot or serial 

number information. 
In the Transaction Lines 
Detail folder window, 
choose the Lot/Serial 
button. 
 

3.1 Enter quantities from related lots of the item.  The 
total of quantities in this screen should be the same 
with the main transaction lines quantity. 

3.2 Note that if the item is Lot Controlled, it is necessary 
to choose the appropriate Lot Number Code. In this 
case click the Lot/Serial button to choose the lot 
number from the list of values. 
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Move Orders 
 
Move orders are requests for the movement of material within a single organization. They allow 
planners and facility managers to request the movement of material within a warehouse or facility for 
purposes like replenishment, material storage relocations, and quality handling. You can generate 
move orders either manually or automatically depending on the source type you use.  
 
Note: Move orders are restricted to transactions within an organization. If you are transferring 
material between organizations, you must use the inter-organization transfer process.  
 
Move Order Source Types 
Oracle provides three types of move orders: 1) Move order requisitions, 2) Replenishment move 
orders, and 3) Pick wave move orders. The move order type refers to the entity that created the move 
order. For all move orders, the final result is one of the two supported transactions: subinventory 
transfer or account issue.  
 
In IITA Move Order Requisitions will be manually created.  Pick Wave Move Orders will be created 
and transacted automatically in MRI processing.  Replenishment Move Orders will not be used. 
 
Move Order Requisitions 
A move order requisition is a manually generated request for a move order. It is available for 
subinventory transfers and account transfers. Once a move order requisition has been approved, it 
becomes an actual move order.  
 
Move Order Components 
A move order comprises the following: 
Move order header: Oracle Inventory uses the move order header to store the move order source 
type. This refers to the entity that created the move order. The header also stores the default source 
and destination (if known by the system), the order number, and the requested date.  
Move order lines: Move order lines are the requests on a move order. They store the item, requested 
quantity, completed quantity (if the move order has been partially fulfilled), and source and 
destination (if known). You can also request specific lot numbers on the move order line. 
Move order line details: The line details are the transactions that occur to fulfil a particular move order 
line.  You should manually fill in the line details and edit them before you transact. If the material is lot 
controlled, the system asks for this information at the line detail level. 
 
Move Order Process Flow 
The move order process follows the following steps: 
1. Create a move order for material. You should manually create a move order requisition. 
2. Approve the move order lines. If the move order requisitions require approval, the item planner 
must approve the move order lines. 
3. Detail the move order. Once the move order is approved, it must be detailed. Detailing is the 
process that determines where to source the material to fulfil a request line. The detailing process 
requires filling in the move order line details with the actual transactions to be performed and 
allocates the material to the move order. 
4. Print a pick slip. Before you transact the move order, you can print a pick slip. 
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5. Transact move order lines. You can either transact all the move order lines at once or transact 
one detail line at a time as the items are moved. If you transact less than the requested quantity, the 
move order stays open until the total quantity is transacted or until the order is closed or cancelled. 
 
Workflow for Move Order Approval Process 
If you require planner approval for move order requisitions, you will use the move order approval 
process, which forwards move order lines to the designated item planner for approval. Oracle 
Inventory manages the approval process through Oracle Workflow. 
 
To govern the move order approval process, two inventory organization parameters have been set: 
Move Order Timeout Period and Move Order Timeout Action. Both have been set as 2 days and 
Reject. The Move Order Timeout Period attribute determines the number of days the order can wait 
for approval. After one time out period, if the recipient has not approved or rejected the order, a 
reminder notice is sent. After a second time out period, the order is automatically rejected. Upon 
approval, additional notifications can be sent to specified individuals. 
 
Print Move Order Pick Slips 
You can print move order pick slips before or after the move order transaction is committed. The 
Move Order Pick Slip report generates pick slips for move order requisitions and replenishment move 
orders. For account issue move orders, these reports should be printed by warehouse keepers and 
sent to the MML unit for final approval. The related move order should then be transacted. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To generate move 

order requisitions. 
 
Note: Use the Change 
Organization function to 
select the Organization for 
which you want to transact 
the Move Order for e.g. 
WAREHOUSES IN 
IBADAN (WII). 

Navigate to the Move 
Orders window: 
 
Oracle Inventory>  
Move Orders>  
Move Orders 
 

1.1 Optionally, enter a Move Order number. To have the 
system automatically generate a number, tab to the 
Description field. 

1.2 Optionally enter an appropriate description. 
Note: The Status field displays Incomplete until the 
move order is approved. 

1.3 Information in the Header block defaults to the tabbed 
regions. These fields can be overridden at the move 
order line level. Enter or select the following: 

 
In the Default section; enter appropriate information in the 
following fields: 
 
1.4 Transaction type e.g. Subinventory transfer or 

Account transfer 
1.5 Source Subinventory e.g. 21 (for PPS Store) 
1.6 Destination Account: The account Flex-field will 

appear and the appropriate account to be charged 
should be entered (this option is only valid for 
Account transfer). 

1.7 Ignore the Ship To Location. 
1.8 Destination subinventory e.g. 11 for CENTRAL 

STORE.  This option is only valid for Subinventory 
transfer. 

1.9 Date required. 
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TRANSACTION NATURE NAVIGATION TASKS 
 
In the Item tabbed region, enter the following information:  
1.10 The line numbers are system generated and you 

cannot change them. 
1.11 Item to be moved (choose from the available list of 

values). 
 
Note: Optionally, choose On Hand to view on–hand 
quantities for items in the source warehouse.  This will 
also show you the correct source locator code. 
 
1.12 Unit Of Measure (the system will show the primary 

unit of measure for the item). 
1.13 Transaction Type – this will be defaulted from the 

header level, do not change it. 
1.14 Enter the Date Required. 
1.15 Quantity to be processed (moved or issued). 
 
In the Source tabbed region: 
1.16 You will see the subinventory code you entered in the 

header – do not change it. 
1.17 Select the source locator code in the locator field – 

make sure this code indicates the correct location 
with the on-hand quantity greater than what you are 
moving (the On-hand button can help you confirm 
this). 

1.18 If the item is lot controlled, select the proper lot 
number for it. 

 
In the Destination tabbed region: 
1.19 You will see the subinventory code you entered in the 

header – do not change it. 
1.20 Select the source locator code to receive the items in 

the in the locator field (Subinventory transfer) or 
select the account to receive the items (Account 
transfer). 

 
In the Control tabbed region: 
1.21 Select a reason for the transaction e.g. MOVEMENT 
 
Attention: If the item is lot controlled, at this point go 
back to the Source tabbed region and select the lot 
number again.  This is very important – do not forget 
to do this. 
1.22 Click the Approve button. 
1.23 The status will change to Pending Approval. 
1.24 Close the window. 
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TRANSACTION NATURE NAVIGATION TASKS 
2. To approve or reject 

move order 
requisitions. 

Notifications Summary 
Window. 

2.1 The item planner willNavigate to the Notifications 
Summary window. Item planners will have approval 
request notification. Item planners should approve 
subinventory transfers but for Account transfer type 
(as you will use in the case of disposals and write 
offs), manual approval is required (International 
House will approve its own Move Orders).  In the 
case of an Account transfer, the item planner 
should not create the move order, as it will be 
automatically approved.   

 
Detailing and Transacting Move Orders 
After a move order has been approved, you must detail the move order lines and then transact the 
move order, to complete the transfer of items to the destination subinventory or account. A move 
order can comprise multiple move order lines. Each move order line is a single request for the 
movement of material. You can either transact all the move order lines at once or transact one detail 
line at a time as the items are moved.  
 
TRANSACTION NATURE NAVIGATION TASKS 
3. To find approved move 

orders for detailing and 
transacting. 

 
Note:  Select the 
Organization for which you 
want to transact the Move 
Order for by using the 
Change Organization 
function e.g. 
WAREHOUSES IN 
IBADAN (WII). 
 

Navigate to the 
Transact Move Orders 
window. The Find Move 
Order Lines window 
appears: 
 
Oracle Inventory>  
Move Orders>  
Transact Move Orders 
 

3.1 On the Find Move Order Lines that appears enter 
search criteria in the Headers tabbed region (in order 
to find approved Move Orders that have not yet been 
detailed and transacted click on the Numbers field 
and select the numbers from the list of values).  You 
can enter as many search parameters as desired – 
the more parameters you enter, the fewer the number 
of move orders you will see.  If you enter no 
parameters, you will see all the approved, pending 
move orders. 

3.2 Choose Find to locate the move order lines you want 
to transact. The Transact Move Orders window 
displays move order lines matching your search 
criteria. 

 
4. To view or update 

move order line 
details. 

Transact Move Orders 
window. 

4.1 Choose the check box for the move order lines you 
want to view or update. Please confirm that the 
source locator code is in the Source Locator field. 

4.2 Choose the View/Update Allocations button. A 
window opens displaying move order line details 

4.3 If the item is lot controlled, please go to the Lot 
Number field and select the same lot number you 
see again. The Expiration date will appear at this 
point. 
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TRANSACTION NATURE NAVIGATION TASKS 
4.4 Enter the Requested Quantity in the Quantity field 

(i.e. as the transaction quantity). 
4.5 When you are through, choose Update to save 

information in the above fields and close the Move 
Orders line details window (this will not transact the 
lines). 

 
5. To transact move 

orders. 
Transact Move Orders 
window. 

5.1 In the Transact Move Orders window choose the 
check box for the move order line you have detailed 
and that you want to transact. 

5.2 Choose Transact. 
5.3 The line will disappear from the window. 
 

 
Printing the Move Order Pick Slip Report 
Use the Move Order Pick Slip Report to print move order pick slips. You can run this report before or 
after the move order transaction is committed. 
 
 NAVIGATION TASKS 
1. To request the Move 

Order Pick Slip. 
Oracle Inventory> 
Reports> Transactions 
 
Confirm that Single 
Request is checked and 
click OK. 
 

Report Submission:  
1.1 Enter Move Order Pick Slip in the Name field to 

submit the report.  
 
Report Parameters: 
1.2 Move Order Number: Select the move order number 

for which you want to print a pick slip. 
1.3 Header ID From / To: Enter a beginning and ending 

header ID number for the move order for which you 
want to print a pick slip. 

1.4 Date Required From / To: Enter the beginning and 
ending date for the period for which you want to print 
a pick slip. 

1.5 Source Subinventory: Select a source subinventory. 
1.6 Source Locator: Enter the source stock locators. 
1.7 Destination Subinventory: Select the destination 

subinventory. 
1.8 Destination Locator: Enter the destination stock 

locators. 
1.9 Requestor: Enter the name of the person requesting 

the move order. 
1.10 Print Options: Select one of the following options:  
� Transacted Lines: To print a pick slip for move 

order lines that have been transacted. 
� Untransacted Lines: To print a pick slip for move 

order lines that have not been transacted. 
� All Lines: To print a pick slip for both move order 

lines that have been transacted and those that 
have not been transacted. 
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Min–Max Planning 
 
You can use min–max planning to maintain inventory levels for all of your items or selected items. 
With min–max planning, you specify minimum and maximum inventory levels for your items. When 
the inventory level for an item drops below the minimum, Oracle Inventory suggests a new purchase 
requisition, internal requisition, move order, or job to bring the balance back up to the maximum. 
 
Oracle Inventory performs min–max planning for your items at either the organization level or the 
subinventory level. Purchase requisitions and internal requisitions for the suggested replenishment 
quantities can be optionally created. You can then turn these requisitions into purchase orders or 
internal orders for the required items.  
 
When you run the Min–Max Planning report, you can have Oracle Inventory create requisitions for by 
answering Yes to Restock. You must also specify a location to serve as the default deliver to location 
on the requisitions. 
 
Oracle Inventory creates purchase requisitions for items when the item attribute Replenishment 
Source Type is set to Supplier, which is the case in IITA.  
 
In IITA, all the items in WII (and any other warehouse organization) are supplier sourced, while all the 
items in IRO are Inventory sourced.  Min-Max planning will only be run for the WAREHOUSES 
organizations and not IRO.  Min-Max planning will also create purchase requisitions.  The level of 
planning can be done at the item planner level, which means that places like PPS, International 
House, Central Store and Medical Unit can plan the inventory levels for their items. 
 
Currently min-max quantities have been defined for all items at the organizational level in IITA hence 
only organizational level planning is possible. 
 
Requesting the Min–Max Planning Report 
To request a min–max planning report you define parameters for min–max planning calculation, 
choose the sorting criterion for the report, and choose whether to create requisitions.  
 
Use the Min–Max Planning Report to show planning information for all items, or items with on–hand 
balances either below or above their assigned minimum or maximum on–hand quantities. You also 
have the option to generate internal or purchase requisitions for all items for which the on–hand 
quantity plus the on–order quantity is less than the min–max minimum amount. 
 
The Min-Max report is organization specific so it is important that you change to the correct 
organization before running the report.  
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TRANSACTION NATURE NAVIGATION TASKS 
1. To request the min–

max planning report. 
 
Use the Change 
Organization function to 
select the organization for 
which you want to run the 
report e.g. WII - 
WAREHOUSES IN 
IBADAN. 
 

Navigate to the Min–
Max Planning window: 
 
Oracle Inventory> 
Planning> Min-Max 
Planning 
 
The Parameters window 

appears. 

 

1.1 Indicate that the Planning Level is set for the whole 
Organization.  Do not select Subinventory.  

1.2 Select the type of item to include on the report in the 
Item Selection field. You can report on Items under 
the minimum quantity, Items over the maximum 
quantity, or All min–max planned items. 

1.3 Enter the Category Set for the report.  The only 
category set currently in use in IITA is Inventory. 

1.4 Please leave the Categories From, To fields blank, as 
we will not be restricting the report on this basis. 

1.5 You can optionally enter item codes in the Items 
From, To fields – the report will be restricted to items 
with codes equal to or higher than the From code and 
equal to or lower than the To code. 

1.6 In the Planners From field, please select the item 
planner whose items the report is to be run for (e.g. 
PPSPLANNER. this will run the report for all the 
items that have been assigned to PPSPLANNER in 
the item master). Do not enter anything in the "To" 
field, or an error will occur.   

1.7 Please leave the Buyers From, To fields blank 
1.8 Enter the Inventory item option as the sorting criterion 

for the report in the Sort by field.  
1.9 Enter the Demand cutoff date and, optionally, the 

Demand Cutoff Date Offset. The report includes 
demand on or before this date.  Examples of demand 
would be approved Internal Requisitions or approved 
Move Orders.  Any of these that has an effective date 
within the defined cutoff date/offset will be considered 
by the system as already taken out of inventory and 
the report will compensate for this. 

1.10 Enter the Supply Cutoff Date and, optionally the 
Supply Cutoff Date Offset. The calculation includes 
open supply orders on or before this date.  Examples 
of supply would be Open Purchase Orders or 
Approved Purchase Requisitions with destination 
being Inventory.  Any of these with an effective date 
within the cutoff date/offset will be considered as 
already in inventory and the report will compensate 
for this. 

1.11 Enter Yes or No in the Restock field to indicate 
whether to restock i.e. answering No will only 
generate the report, answering Yes will generate the 
report and also create information for the interface 
tables of Purchase Requisitions. Please select Yes 
unless you are only running the report for information 
purposes and not to replenish the inventory. 
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TRANSACTION NATURE NAVIGATION TASKS 
1.12 Please leave the Repetitive Item option blank as this 

is not currently used in IITA. 
1.13 Select the default delivery location in the Default 

Delivery To field e.g. IITA_IBADAN. 
1.14 Please leave the Net Reserved Orders, Net 

Unreserved Orders, Net WIP Demand Include PO 
Supply, Include WIP Supply and Include Interface 
Supply fields at their system defined values (usually 
Yes) 

1.15 Delete the Include Nonnettable Subinventories option 
and leave it blank. 

1.16  Choose Yes for Lot Control field if you want to plan 
only Lot Controlled Items, or choose No, if you want 
to plan only Not Lot Controlled Items. 

1.17 Choose the following Display Format option: Display 
All Information 

1.18 Indicate whether to display the item description in the 
Display Item Description field by selecting Yes or No. 

1.19 Click OK to close the Parameters window 
1.20 To select the printer for the report, click on the 

Options button.  Under the Print Output To: section, 
click the list of values in the Printer field and select an 
appropriate printer e.g. MML_HP2100N, 
PPS_PRINTER, etc, and click OK. 

1.21 Enter the number of copies desired e.g. 1. 
1.22 Click OK and Choose the Submit button to launch the 

report. 
1.23 Answer No to the Submit another request? decision 

prompt. 
 

 
Min-Max Requisition Creation Process (Requisition Import Process) 
If you selected Restock = Yes when generating the Min-Max report, and in viewing the report you 
saw that some items need to be ordered, the requisition import process must be run to create 
requisitions from the min-max report.  The requisition import process can be run only in the 
purchasing responsibility (either super user or buyer) 
 
Requisition Import calls the PO Requisition Approval workflow to submit the requisitions to the 
approval process unless you specify not to when you submit Requisition Import.  
 
When you submit the Requisition Import process, Purchasing automatically prints the Requisition 
Import Run Report. You can view this report by using the View Requests window and choosing the 
Report option in the View field for the Requisition Import process you submitted. If there were no 
records in the transaction interface table, the report has two lines: 
•No records were processed 
•Number of records in error = 0 
Otherwise, the report normally has three lines (let us assume that 13 requisitions have been created): 
•Number of approved requisitions created = 0 
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•Number of unapproved requisitions created = 13 
•Number of interface lines in error = 0 
When there are transaction records that cannot be processed, the report includes a fourth line 
(assuming that 3 lines could not be processed): 
•Number of records pending = 3. 
 
When there is an error in processing any of the transaction records, (i.e. Number of interface lines in 
error shows that some lines have errors), you will have to run the Requisition Import Exceptions 
Report to determine the cause of the errors (Oracle Purchasing> Reports> Run> - Requisition Import 
Exceptions Report). 
 
TRANSACTION NATURE NAVIGATION TASKS 
2. To run the requisition 

Import process. 
Navigate to the Submit 
Requests window: 
 
Oracle Purchasing> 
Reports> Run 
 

2.1 Click on Submit a New Request. 
2.2 Confirm that Single Request is selected and click on 

OK. 
2.3 Enter Requisition Import as the request name and 

press the tab key. 
2.4 Enter the Import Source: INV. 
2.5 If you do not see a particular import source in the list 

of values it means that there are currently no 
requisitions from that source.  This would be an 
indication that the Min-Max report did not generate 
the requisition interface lines – go back and review 
the Min-Max planning report generation steps. 

2.6 Leave the Import Batch Identification field blank to 
import all batches. 

2.7 Use the Group By feature to determine how 
requisition lines are grouped on the requisitions you 
create.  Unless you have any special requirements, 
you should leave this at the default option of All which 
will group all the requisition lines on a single 
requisition.. 

2.8 Leave the Last Requisition Number field blank to 
automatically get the next available requisition 
number. 

2.9 Choose No for Multiple Distributions. 
2.10 Choose whether to initiate approval automatically for 

the requisitions after they are imported. 
� Yes: The PO Requisition Approval workflow is 

launched automatically for requisitions imported 
with a status of Incomplete. 

� No: The PO Requisition Approval workflow is not 
automatically launched for Pre–Approved or 
Incomplete requisitions. You can submit these to 
the approval process later, when you select the 
Approve button on the requisition.  It is strongly 
recommended that you choose No so that you 
can review the requisition before sending for 
approval, and so that you can also choose the right 
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TRANSACTION NATURE NAVIGATION TASKS 
approval hierarchy. 

2.11 Click OK and choose Submit to begin the process. 
2.12 Answer No to the Submit another request? decision 

prompt. 
 

 
Updating Incomplete Imported Requisitions 
As a requisition preparer, you can change the information on a requisition before you send it through 
the approval process. To update a requisition you created using the Requisitions window or 
requisitions import process, simplyNavigate to the Find Requisitions window and query up the 
requisition. 
 
Once you send a requisition through the approval process, your access to it is determined by the 
security and approval structure. 
 
TRANSACTION NATURE NAVIGATION TASKS 
3. To view the imported 

requisitions in the 
Requisition Headers 
Summary window. 

Navigate to the 
Requisition Summary 
window: 
 
Oracle Purchasing> 
Requisitions> 
Requisition Summary 
 

3.1 In the Find Requisitions window, click on the list of 
values in the Preparer field (second from the top) and 
select your name from the list of values. 

3.2 Click on the Status tab (near the middle of the form to 
the left) and select the option Incomplete from the 
Approval field. 

3.3 Click on the Date Ranges tab (next to the Status tab) 
and in the Creation Date field click on the list of 
values button to bring up a calendar that will enable 
you to select the date you ran the requisition import 
process (it will be today’s date if you ran the 
requisition import today).  Click OK to acknowledge 
the date selected. 

3.4 Select Headers in the Results region (towards the 
right side of the form near the bottom) and. 

3.5 Select the Find button to open the Requisition 
Headers Summary folder window. 

  
4. To open the requisition 

window for the 
imported requisition. 

Requisition Headers 
Summary folder 
window. 
 

4.1 Select the line corresponding to the requisition you 
want to process and click the Open button to open 
the Requisitions window for the requisition on the 
current line, which will be the requisition (or one of the 
requisitions depending on the options you earlier 
chose), created by requisition import. 

 
5. Specifying the 

subinventory code for 
each requisition line. 

Requisitions window. 5.1 Select each line and for each, specify the destination 
subinventory code in the subinventory field at the 
bottom of the form.  You must not forget to do this 
for every line. 

 
 



 

 25

Note: Please note that the following steps should be followed only if it is decided that they are 
necessary: 
 
TRANSACTION NATURE NAVIGATION TASKS 
6. Deleting a Requisition 

Line. 
 Requisitions window. 6.1 Select the requisition line and select Delete from the 

Edit menu.  Answer OK to the “Delete this record?” 
prompt 

 
7. Adjusting the 

requisition 
description. 

 

Requisitions window. 7.1 Click in the description field and edit/adjust the 
description. 

8. Adjusting line 
quantities. 

Requisitions window. 8.1 Select the relevant requisition line. 
8.2 Tab to the Quantity column. 
8.3 Adjust quantity to any desired value. 
8.4 Save your work. 
 

9. Adjusting line prices. Requisitions window. 9.1 Select the relevant requisition line. 
9.2 Tab to the price column. 
9.3 Adjust price to the proper value. 
9.4 Save your work. 
(See Adjusting Currency for more on price implications in 
Foreign Currency (non USD) transactions) 
 

10. Adjusting currency.  10.1 Select the relevant requisition line. 
10.2 Tab to the currency column. 
10.3 Select any currency (e.g. NAI - Nigerian Naira) from 

lookup. 
10.4 Tab to the Rate Type column and select Corporate. 
10.5 Tab to Rate Date column and select today's date. 
10.6 Tab to price column under the "Foreign Currency" 

section and update the price to the price in the 
selected currency. 

10.7 Save your work. 
 

 
For more information, please refer to the IITA Oracle Tutor user guides for creating Purchase 
Requisitions. 
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Physical Inventory  
 
Oracle Inventory provides an automated physical inventory feature that you can use to reconcile 
system–maintained item on–hand balances with actual counts of inventory. Accurate system on–
hand quantities are essential for managing supply and demand 
 
Steps Involved 
� Define a physical inventory for your whole warehouse or subdivisions within your warehouse 

(depending on how your subinventories are defined).  
� Take a snapshot of system on–hand quantities.  
� Generate alphanumeric tags.  
� Void unused or lost tags. 
� Approve or reject physical inventory adjustments  
� Automatically post adjustments to inventory balances and general ledger accounts.  
� Purge physical inventory information.  
 
You can define and maintain an unlimited number of physical inventories in Oracle Inventory. A 
physical inventory is identified by a unique name you assign. You can define multiple physical 
inventories to count selected portions of your inventory (i.e. subinventories), or you can count your 
total inventory (organization). 
 
Taking a Snapshot of Inventory Quantities 
Before you can generate tags for a physical inventory, you must take a snapshot of all system on–
hand quantities for your items. The snapshot saves all current item on–hand quantities and costs. A 
snapshot is like a picture of the current state of the inventory against which actual counts are 
compared.  Oracle Inventory uses this information as the basis for all physical inventory adjustments. 
All tag counts you enter for this physical inventory are compared with these snapshot quantities. This 
allows you to resume normal inventory operations after you have entered your counts but before you 
have authorized all final physical inventory adjustments. 
 
You can therefore perform your recounts or investigate certain results without holding up transaction 
processing. 
 
Attention: Oracle Inventory does not stop inventory processing during a physical inventory. 
Therefore, you must procedurally co-ordinate the snapshot of your physical inventory with your actual 
counting, and ensure that no transaction activity occurs in a particular location until after you have 
counted its contents.  
 
Physical Inventory Tags  
Oracle Inventory can generate default tags for your physical inventory. If you choose to generate 
default tags for each item, specify the starting tag number and the increment by which you want to 
increase each digit in the tag number. Your tag numbers may be alphanumeric, but you can 
increment only the numeric portion. The alphabetic characters in the tag number stay constant. 
Inventory then uses these tag numbers to generate a tag for every unique combination of item, 
subinventory, locator, and lot for which the system has an on–hand quantity not equal to zero. 
 
You use physical inventory tags to record the physical counts of inventory items. Physical inventory 
tags represent actual hard copy tags that are used to count inventory items. A tag contains the count 
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for a group of a given item. Although you can record only one item on a tag, multiple tags can 
reference the same item, with each tag referring to a unique physical location for an item. 
 
Physical Inventory Counts 
After conducting the count using the printed tags, you can automatically query the tags and fill in the 
counts. Oracle Inventory uses the counts you enter for your tags to determine if your items need 
quantity adjustments. 
 
Voiding Tags (if necessary) 
It is important for auditing purposes to track the status of each physical inventory tag. Therefore, if 
you do not use one or more of the tags Oracle Inventory generates, you should void them in the 
Physical Inventory Tag Counts window. A voided tag is not reported as a missing tag in the Physical 
Inventory Missing Tag Listing. If you void a default tag, (i.e. a tag that identifies a stock–keeping unit 
for which there is a system on–hand quantity), Oracle Inventory adjusts the quantity in that location to 
zero. This indicates that you did not use the tag in question, presumably because the stock–keeping 
unit corresponding to the tag did not exist. 
 
Approving Physical Inventory Adjustments 
You can view, reject, or approve physical inventory adjustments pending approval. The adjustments 
you can view from this window are determined by the approval option you defined for your physical 
inventory. If you approve a particular adjustment, the Process Physical Inventory Adjustments 
program adjusts your inventory balance by that quantity. If you reject an adjustment, Oracle Inventory 
does not change the system on–hand quantity. 
 
Processing Physical Inventory Adjustments 
After you finish entering all your tag counts and approving those adjustments that need approval, you 
can submit the process that automatically posts your physical inventory adjustments. Oracle 
Inventory automatically creates a material transaction adjusting the item quantity and debiting or 
crediting the adjustment account you specify for your physical inventory. If the count of an item 
matches the snapshot system on–hand quantity, there is no adjustment transaction posted. 
Once you run the adjustment program for your physical inventory, Oracle Inventory does not allow 
new tag generation or any further updates of tag counts. You are no longer able to make any 
changes to that physical inventory. Due to the irreversible nature of this program, Oracle Inventory 
posts no physical inventory adjustments if you have any adjustments that are still pending approval. 
You must approve or reject all of your adjustments before you can process them. You can preview 
your adjustments before actually posting them by running the Physical Inventory Adjustments Report. 
You can run the actual adjustment program after you have used the report to verify your tag 
quantities and the value impact of your adjustments. 
Attention: For any tag that has no count entered, Oracle Inventory assumes a count of zero and 
performs adjustment transactions accordingly. Therefore, you should make it a part of your physical 
inventory procedure to run the Physical Inventory Missing Tag Listing before you process 
adjustments. 
 
Purging Physical Inventory Information 
In this process Oracle Inventory deletes all information associated with the physical definition. 
However, the purge does not affect any adjustments or adjustment transactions made using the 
physical definition. Those adjustments are not changed. You can also purge just tags if you made a 
mistake and want to start over. 
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Note:  Please select the appropriate organization by using Change Organization function before starting the 
Physical Inventory (e.g. Change Organization to WII = WAREHOUSES IN IBADAN).  This will be the active 
organization for the duration of the physical inventory transactions in the system. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To define a physical 

inventory. 
Navigate to the Physical 
Inventories Summary 
folder window and 
choose New: 
 
Oracle Inventory> 
Counting> Physical 
Oracle Inventory> 
Physical Inventories 
 
The Define Physical 

Inventory window appears. 
  

1.1 Enter a unique physical inventory name following this 
naming convention: SUBINVENTORY CODE_DATE 
e.g. 21_03SEP2001, press tab and enter a 
description for the Physical Inventory e.g. PPS END-
OF YEAR STOCK COUNT (2001). 

1.2 Select the Always option in the Approvals Required 
for adjustments. 

1.3 Select the scope of the physical inventory under the 
Count Subinventories section.  Determine whether 
the physical inventory is for all subinventories or for 
one or more specific subinventories.  

1.4 For the specific subinventory, you should select the 
code from the list of values in the field under the 
Specific option. 

1.5 Indicate dynamic entry of tags will be allowed by 
making sure the Allow Dynamic Tags option is 
checked (i.e. manual tags can be used in addition to 
the system generated ones). 

1.6 Save your work and leave the Define Physical 
Inventory window open for the next step. 

 
2. To take a snapshot of 

the system on–hand 
quantities. 

Define Physical 
Inventory window. 
 
Choose the Snapshot 
button or choose 
Perform Snapshot from 
the Tools menu.  
 
This launches the 
snapshot process 

2.1 Answer OK to the notification of request submission. 
2.2 When the snapshot process is finished, re–query the 

physical inventory to see the effects of the snapshot. 
You can re-query by closing the Define Physical 
Inventory window, which returns you to the Physical 
Inventories Summary folder window, and selecting 
Run from Query by Example under the View menu.   

2.3 Select the line for the Physical Inventory you have 
just created and click the Open button. 

 
The effects you will see in the Define Physical Inventory 
window include: 
� Snapshot Complete box is checked 
� Snapshot Date is updated 
� Tags button at the bottom of the window is enabled  
 

3. To generate tags. Choose the Tags button 
from the Define 
Physical Inventory 
window or choose 
Generate tags from the 
Tools menu 

3.1 Check that option to Generate default tags is enabled 
in the Tag Type section and ignore the Show Serial 
on Tags option (as serial numbers are not used in 
IITA inventory management). 

3.2 Enter the starting tag number in the Starting Tag field 
using this convention: SUBINVENTORY 
CODE_000001 (e.g. 21_000001). 
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TRANSACTION NATURE NAVIGATION TASKS 
3.3 Change the number in the Digit Increments field to 

000111111. 
3.4 Ignore the ending tag number and the number of tags 

as Inventory calculates these values for you when 
you select Default tags in the Tag Type field. 

3.5 Choose the Generate button to create the tag 
numbers and information. Answer OK to the 
notification of request submission. 

3.6 Close the Generate Physical Inventory Tags form, 
(which should at this point be blank), the Define 
Physical Inventory window, and the Physical 
Inventories Summary folder window. 

 
4. To print the tags.  
 
Use the Physical 
Inventory Tags report to 
print tags you have 
generated. 

Oracle Inventory> 
Reports> ABC and 
Counting 

4.1 Confirm that Single Request is selected and click on 
OK. 

4.2 Enter Physical Inventory Tags as the request name 
and press the tab key this takes you to the 
parameters window. 

4.3 Select the Physical Inventory you created in the 
Physical Inventory field from the list of values. 

4.4 Select the Subinventory for which you are conducting 
the count from the Subinventory field. 

4.5 Select the Subinventory, Locator option in the Sort 
By field 

4.6 Select Full Listing from the Range field 
4.7 Ignore From Tag, To, From Locator, To, From Item 

To (unless you decide you do not want to count all 
locations or all items) 

4.8 Click OK to close the Parameters window 
4.9 To select the printer for the report, click on the 

Options button.  Under the Print Output To: section, 
click the list of values in the Printer field and select an 
appropriate printer e.g. MML_HP2100N, 
PPS_PRINTER, etc, and click OK. 

4.10 Enter the number of copies desired e.g. 1. 
4.11 Click OK and Choose the Submit button to launch the 

report. 
4.12 Answer No to the Submit another request? Decision 

prompt. 
4.13 Use the tags that you generated and printed to record 

your physical counts. 
5. To display physical 

inventory tag 
information and enter 
counts for tags. 

Navigate to the Physical 
Inventory Tag Counts 
window: 
 
Oracle Inventory> 
Counting> Physical 
Oracle Inventory>  

5.1 Select the physical inventory name from the list of 
values. 

5.2 Confirm that the name of the employee that 
performed the physical inventory is in the Default 
Counter field. Otherwise change the name of the 
employee 
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TRANSACTION NATURE NAVIGATION TASKS 
Tag Counts 
 

5.3 Enter or query the tag numbers for which to enter by 
clicking on the Find button.  Choose Yes or No to 
query all tags. If you choose No, you can enter tag 
numbers individually.  When you enter a tag number 
the item information for that tag appears. 

5.4 Enter the count information: For each tag, confirm 
that the UOM displayed is the same as the UOM 
counted (otherwise change the UOM code), enter the 
count quantity under the Qty column and if you want 
to change the Counted By name from the Default 
Counter, press tab and select a new name from the 
list of values button in the Counted By field.  You can 
use the tab key to move from line to line.  If any of the 
tags were discarded (not used) or missing, you can 
check the Void option under the Void column on the 
line for the tag.  You should not void any tags if all 
the tags were actually used. 

5.5 Save your work and close the window. 
 
Note: If you have voided any tags and you want to unvoid 
them, all you have to do is uncheck the Void option. 
 

6. To select the physical 
inventory and display 
the adjustments for 
approval. 

Navigate to the Approve 
Physical Adjustments 
Summary window: 
 
Oracle Inventory> 
Counting> Physical 
Oracle Inventory> 
Approve Adjustments 

6.1 Select the name of the physical inventory from the list 
of values to the right of the name field. 

6.2 Enter the name of the employee approving the 
adjustments. 

6.3 Click the Find button to start the search. The results 
display in the Approve Physical Adjustments 
Summary window. 

 
7. To approve or reject 

adjustments. 
Approve Physical 
Adjustments Summary 
window. 

7.1 Examine the information on the Adjustments tab 
under the Adjustment column for each adjustment 
line.  You will see the Item code, the quantity that was 
recorded in the system snapshot, the unit of measure 
for this item, the adjustment quantity (a negative in 
red is a downward adjustment, a positive is an 
upward adjustment), the material value of the 
adjustment and finally the percentage of the 
adjustment (relative to the snapshot quantity). 

7.2 Select adjustments to reject or approve, and check 
the Approve or Reject option. 
Attention: You must either reject or approve all 
adjustments for a physical inventory before you can 
start processing your adjustments.   If you do not and 
leave some with an approval status of None, you will 
not be able to process your adjustments, as you will 
get an error at that stage. 

7.3 Save your work. 
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If you reject any adjustments, please do the following: 
7.4 Conduct any necessary investigation as to why there 

is a variance in on-hand quantity and actual count 
and if necessary recount the items using the same 
printed tags as before.   

7.5 Return to the Tag counts window and update any 
quantity found to be different from the initial count 
quantity and save the new counts.   

7.6 Return to the Approve Physical Adjustments 
Summary window. 

7.7 Approve all the adjustments. 
7.8 Save your work. 
 

8. To run the adjustment 
program for processing 
physical inventory 
adjustments. 

Navigate to the Physical 
Inventories Summary 
folder window: 
 
Oracle Inventory> 
Counting> Physical 
Oracle Inventory> 
Physical Inventories 

8.1 Select the physical inventory you want to use by 
clicking on the Torch icon on the toolbar at the top of 
the screen (which activates the Find function) and 
select the physical inventory for which you want to 
run the adjustment program. 

8.2 Choose Launch adjustments from the Tools menu. 
The Launch Adjustments window appears. 

8.3 Enter the Adjustment Account number against which 
adjustments should be charged.  This account should 
be confirmed from Budget and Finance.  The current 
account for adjustments is 01.8053.1015. 
000000000.0000000.  To enter this account select 
the list of values in the Adjustment Account field 
located on the right side of the field, enter 01 as the 
company, 8053 as Account, 1015 as Cost Centre, 
000000000 as Reserved and 0000000 as Donors and 
click OK. 

8.4 Enter the adjustment date. 
8.5 Choose the Launch Adjustments button to submit the 

request for adjustments, and answer OK to the 
request submission notice. 

 
9. To purge physical 

inventory information. 
 

Navigate to the Physical 
Inventories Summary 
folder window: 
 
Oracle Inventory> 
Counting> Physical 
Oracle Inventory> 
Physical Inventories 

9.1 Select Find from the View menu 
9.2 Select the Physical Inventory you want to use. 
9.3 Choose Perform purge from the Tools menu. 
9.4 Choose Tags Only to purge only tags in the physical 

inventory or All to purge the entire physical inventory. 
9.5 Click on the Purge button to start the process 
9.6 Click on OK to acknowledge the request submission 
 

. 
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Physical Inventory Reports 
You can use a number of reports to help you during the process of performing a physical inventory and to 
analyze and report the results of physical inventory adjustment transactions. 
 
Physical Inventory Tag Listing This report lists all the tags that you generated and all the dynamic tags that 
you entered. The report shows the tag number, item, revision, subinventory, locator, lot, and serial number for 
each tag used in your physical inventory. You can use this report as the document you give to the employees 
performing the counts. You can also use this report as a complete count history after all counts have been 
completed. 
 
Physical Inventory Counts Report This report shows information on the tags you enter for a physical 
inventory, including the item, item controls, count location, count quantity, and count value. 
 
Physical Inventory Missing Tag Listing This report lists the tags that are missing from a user–specified range 
of tag numbers. The report also shows what information was printed on the tag, if any, to aid in the search. 
Oracle Inventory considers as missing those tags for which you have not entered counts. Void tags are not 
considered to be missing. Use this report before initiating physical adjustments to verify that you have accounted 
for all tags generated by the system. Otherwise, if you have not entered a count for a tag and approvals are not 
required, Oracle Inventory adjusts your on–hand balances down to zero quantity. 
 
Physical Inventory Adjustments Report This report shows all adjustments against unique combinations of 
item, revision, subinventory, locator, lot, and serial number for a user–specified physical inventory. You can run 
this report before processing your adjustments to get a preview of your adjustment quantities and values. You 
can then determine whether you are ready to process all final adjustments or whether you need to recount 
certain locations. This report is also automatically generated after the successful completion of the adjustment 
program as a record of what was actually adjusted. 
 
Physical Inventory Accuracy Analysis You can run the Physical Inventory Accuracy Analysis report many 
times during your physical inventory. If you run it after you take a snapshot of your on–hand balances, this report 
shows the system on–hand quantity and value for each item included in your physical inventory. If you run this 
report after entering your tag counts, it shows the actual count quantities and values, as well as the adjustment 
quantity, value and error percentage for each count you entered. You can also use this report as a historical 
accuracy analysis tool. 
 
Physical Inventory Summary Report This report provides a summary of your physical inventory adjustments 
by subinventory. You can see, in your functional currency, the system on–hand value, the actual count value, 
and the resulting adjustment value, as well as the number of tags and adjustments performed for each 
subinventory. You can also use this report as a management tool to monitor the accuracy of your inventory as it 
also includes the error percentage of your original system on–hand quantities and values. 
 
Physical Inventory Trend Report This report compares past physical inventories so that you can see whether 
record accuracy has improved over time. It provides a summary of physical inventory adjustment values, by date 
and subinventory, as well as the number of tags and adjustments each subinventory required. You can view 
subtotals for each physical inventory as well as a grand total of all your physical inventory adjustments over time. 
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ABC Analysis and Cycle Counting 
 
ABC Analysis  
 
An ABC analysis determines the relative value of a group of inventory items based on a user–
specified valuation criterion. ”ABC” refers to the rankings you assign your items as a result of this 
analysis, where ”A” items are ranked higher than ”B” items, and so on. You have to use the ABC 
analyses you compile to drive your cycle counts, where you might count items of high value (A items) 
very frequently, items of lower value less frequently, and items of lowest value very infrequently. 
 
Steps Involved 
� Define and run an ABC compilation. 
� Define ABC classes 
� Define ABC groups 
� Assign items to ABC classes within a group. 
� Update item assignments. 
 
Defining an ABC Compile 
You can define and compile an ABC analysis for your entire organization or for a specific 
subinventory within your organization. In IITA, ABC compiles will be defined on the subinventory 
level.  You choose the compilation criterion, the scope of your analysis, the cost type to use in 
determining item values, and any additional information that may be conditionally necessary, based 
on your compilation criterion. The combination of all these parameters constitutes an ABC compile 
header, identified by the ABC compile name. You use this name to identify any activity pertaining to 
this ABC analysis. 
 
Oracle Inventory uses the compile criterion to value the items you include in your ABC compile. After 
determining each item’s value, Oracle Inventory ranks all the items in your ABC compile in 
descending order to produce the printed ABC Descending Value Report. 
 
You should use this report as a guide in assigning your items to ABC classes. 
 
Defining ABC Classes 
You use ABC classes to identify the value groupings to which your items belong. You define these 
classes using your own terminology. For example, you might define classes High, Medium, Low, and 
later assign your items of highest rank to the High class, those of lower rank to the Medium class, 
and those of lowest rank to the Low class. You can add to the list of classes already defined. 
 
In IITA the following classes will be defined: 
A - HIGH VALUE ITEMS 
B - MID VALUE ITEMS 
C - LOW VALUE ITEMS 
D - SECURITY ITEMS (PRONE TO THEFT) 
E - HAZARDOUS OR RESTRICTED LIFE ITEMS 
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Defining ABC Assignment Groups 
ABC assignment groups link a particular ABC compile with a valid set of ABC classes. 
Oracle Inventory uses these groups when you automatically assign your items to ABC classes. It 
ensures that you divide your items into the exact number of groupings you specified in the ABC 
group. You must also assign a sequence number to each class associated with the ABC group (the 
sequence numbers can be obtained from the ABC Descending Value Report). The class with the 
lowest sequence number is assumed to have the highest rank and will have higher rank items 
assigned to that class than the next higher sequence number. Using the ”A”, ”B”, and ”C” classes in 
the example above, you might assign the ”A” class a sequence number of ”1”, the ”B” class a 
sequence number of ”2”, and the ”C” class a sequence number of ”3”. (Sequence numbers ”10”, ”20”, 
and ”30” would give the same result.) When you later assign your items to ABC classes, the first 
grouping of items in the descending value list are assigned to class ”A”, the next to ”B”, and the last 
to ”C”. 
 
You may update an assignment group to add new classes. However, you cannot delete a class. If 
you need to delete a class, you must create a new assignment group with only the desired classes. 
 
Defining ABC Item Assignments 
You can assign and update ABC classes to an ABC assignment group where an ABC compile was 
also entered. From the ABC Descending Value Report you determine the cutoff points for assigning 
ABC classes. You can then use the classifications for other purposes such as determining how often 
you cycle count a given item. 
 
Updating ABC Item Assignments 
If you are not satisfied with the class into which an item falls as a result of the automatic ABC 
assignment process, you can change it by updating the item assignment.  This will be used in re-
assigning items to the D and E classes. 
 
Attention: Whenever you recompile an ABC analysis or change the method by which you assign 
your ABC classifications, you lose any changes you might have made to your item assignments. All 
items are reclassified based on their new ranks in the ABC Descending Value Report and the method 
you choose to determine cutoff points. You can also update an ABC group to include those items that 
were not a part of the initial ABC compile. This allows you to expand the scope of your existing ABC 
compiles without having to rerun any processes.  For example, if you start stocking a new item in 
your inventory, you can make it a part of your existing ABC groupings through the update 
process. Otherwise, you would have to start all over by recompiling your ABC analysis and 
reassigning your items to ABC classes. With the whole process starting from the very beginning, you 
also run the risk of losing any changes you might have made to your item assignments. 
 
Before you begin: 
Please select the Organization for which you want to conduct the cycle count by choosing Change 
Organization and then selecting the organization (e.g. WII – WAREHOUSES IN IBADAN) and 
clicking OK. 
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TRANSACTION NATURE NAVIGATION TASKS 
1. To define, run and 

print an ABC compile. 
Navigate to the ABC 
Compiles folder window 
and choose New. 
 
Oracle Inventory> ABC 
Codes> ABC 
Compiles> New 

1.1 Enter a unique name for the ABC compile in the 
Compile Name field following this naming convention: 
SUBINVENTORY CODE_ABC_COMPILE_DATE 
e.g. 21_ABC_COMPILE_03-SEP-2001, and a 
description of what the name means in the 
Description field. 

1.2 Select a specific subinventory for the scope of the 
analysis in the Content Scope section (select a 
subinventory from the Subinventory list of values). 

1.3 Select Subinventory in the Valuation Scope section. 
1.4 Select Current on–hand value as the criterion in the 

Compile Specification section 
1.5 Enter Average as the Cost Type.  
1.6 Ignore the Forecast and Plan Name options and the 

From Date and To Date. 
1.7 Save your work. 
1.8 Click on the Compile button on the top right section of 

the window. 
1.9 Answer OK to the request submission notice. 
1.10 Answer Yes to the Print compile results? Prompt. 
1.11 Answer OK to the request submission notice. 
1.12 Close the window. 
1.13 Select Requests from the View menu. 
1.14 Click on the Find button. 
1.15 Select Reprint from the Tools menu. 
1.16 Enter 1 in the Copies field. 
1.17 Click the list of values in the Printer field and select 

an appropriate printer e.g. MML_HP2100N, 
PPS_PRINTER, etc, and click OK. 

1.18 Close the Requests window. 
 

2. To optionally view ABC 
Compile results on the 
computer. 

Navigate to the ABC 
Compiles window: 
 
Oracle Inventory> ABC 
Codes> ABC Compiles 

2.1 When you are in the ABC Compiles window, select 
Find from the View menu. 

2.2 Select the ABC compile whose results you want to 
view and click OK. 

2.3 Choose View Compile from the Tools menu. The 
ABC Compile Items window appears. 

2.4 View the list and when you are satisfied, close the 
ABC Compile Items window. 

 
3. To define an ABC 

class. 
Navigate to the ABC 
Classes window: 
 
Oracle Inventory> ABC 
Codes> ABC Classes 

3.1 Enter a unique name for each class on each line 
under the Class Name column (i.e. A, B, C, D or E) 
and a description (i.e. - HIGH VALUE ITEMS, MID 
VALUE ITEMS, LOW VALUE ITEMS, SECURITY 
ITEMS (PRONE TO THEFT), HAZARDOUS OR 
RESTRICTED LIFE ITEMS) 

3.2 Save your work. 
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4. To define an ABC 

assignment group. 
Navigate to the ABC 
Assignment Groups 
window: 
 
Oracle Inventory> ABC 
Codes> ABC 
Assignment Groups 

4.1 Select New from the File menu and enter a unique 
ABC group name following the convention 
SUBINVENTORY CODE_ABC_GROUP_DATE e.g. 
21_ABC_GROUP_3-SEP-2001. 

4.2 To assign items to this ABC group using an ABC 
compile, under the Compile Name column, select the 
ABC compile you defined from the list of values in the 
field (e.g. 21_ABC_COMPILE_03-SEP-2001) 
Oracle Inventory displays the subinventory and the 
valuation associated with that ABC compile. 

4.3 Save your work. 
 

5. To enter classes to 
use with an ABC 
group. 

Choose the Group 
Classes button.  
 
The ABC Group Class 
Assignments window 
appears. 
 

5.1 Enter the priority in which classes are ordered. The 
lower the number the higher the importance of the 
class.  For example assign the Priority 1 to A, 2 to B 
and so on. 

5.2 Select the name of the class to use with this ABC 
group (for each priority i.e. A, B, C, etc). 

5.3 Save your work and close the ABC Group Class 
Assignments window. 

 
6. To define ABC 

assignments. 
Choose the Assign 
Items button. 

6.1 Specify the cutoff point for each ABC class. Each 
ABC class must have at least one item assigned to it, 
and all items in the ABC compile must be assigned to 
an ABC class. You can use any of the following fields 
to determine the cutoff points: 

 
Seq: You can enter the sequence number from the 
ABC Descending Value Report for the last item to be 
included in each ABC class (i.e. if you enter 3 as the 
Seq number for A, all items with a sequence number 
before or on 3 will be assigned to the A class, if you 
then go on to enter 7 in the B class, all items with a 
sequence number greater than 3 up to 7 will be 
assigned to B and so on). Oracle Inventory 
automatically calculates this value if you choose to 
assign classes by another method. Oracle Inventory 
displays the last sequence number as the default for 
the last class. 

 
As you enter the Seq numbers, you will see the 
Inventory Value of each class and the total 
percentage of the items you have assigned.  On the 
last row, you must have a total percentage of 100 
otherwise there are some items you have not yet 
assigned.  If this happens, please cross check with 
the ABC Descending Value Report to see that all the 
sequence numbers have been assigned. 



 

 37

TRANSACTION NATURE NAVIGATION TASKS 
Inventory Value: You can enter the cumulative value 
from the ABC Descending Value Report for the last 
item to include in each ABC class. Oracle Inventory 
automatically calculates the maximum value. This 
maximum value is restricted to the total inventory 
value compiled and is displayed in the Total Compile 
Value field. Oracle Inventory displays the total 
inventory value as the default for the last class. 
 
% Items: You can enter the percent of number of 
items compiled from the ABC Descending Value 
Report to include in each class. Oracle Inventory 
automatically calculates this value if you choose to 
assign classes by another method (e.g. Seq 
numbers).  It is recommended that you allow 
Oracle Inventory perform the automatic 
calculation. 

 
% Value: You can enter the percent of total compile 
value from the ABC Descending Value Report to 
include in each class. Oracle Inventory automatically 
calculates this value if you choose to assign classes 
by another method (e.g. Seq numbers).  It is 
recommended that you allow Oracle Inventory 
perform the automatic calculation. 
 
Note: As much as possible, try to assign all items to 
A, B and C classes (you can assign the last two 
sequence numbers to D and E) – relevant items can 
be re-assigned to the D and E classes with the 
update ABC item assignment process. 
 

6.2 Choose the Assign button to launch the request to 
assign the items to the classes in the ABC group. 

6.3 Click OK to acknowledge the request submission. 
6.4 Close the Assign ABC Items window. 

7. To update an ABC 
item assignment or 
enter items that were 
not part of an ABC 
compile. 

Choose the Update 
Items button on the 
ABC Assignment 
Groups window. 
 

7.1 If necessary, change the class of any of the items as 
desired by changing the letter in the ABC Class 
column.  If you did not add D and E classes to your 
ABC groups before, you mayNavigate to the main 
ABC Assignment Groups window, click on Group 
Classes, and add these classes  

7.2 If you also want to insert more items on the ABC 
assignment, select New from the File menu, click on 
the list of values button and select an item, then enter 
a class code in the Class column.  This assignment 
will be valid for only this ABC Group’s subinventory. 

7.3 Save your work 
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Cycle Counting 
 
Cycle counting is the periodic counting of individual items throughout the course of the year to ensure 
the accuracy of inventory quantities and values. 
 
There will be only one Cycle Count defined for each subinventory or group of subinventories (every 
year).  These counts will then be run everyday and the selected items will be counted and any 
needed adjustments can be made.  At the end of the year after the last count is run, the cycle count 
data can then be purged from the system in anticipation of the next year’s schedule. 
 
Tasks Involved: 
 
Beginning of the year: 
� Define a cycle count on the subinventory level. 
� Define cycle count classes. 
� Define cycle count items. 
� Automatically schedule item counts using ABC count frequencies. 
Daily: 
� Generate daily count requests and lists. 
� Enter counts. 
� Approve, reject, or request recounts for cycle count adjustments 
End of the year: 
� Purge cycle count information. 
 
Attention:  Please note that if new items are defined and introduced into inventory, the process for 
specifying cycle count items will have to be repeated at this point so that the new items can be 
included.   
 
Before you begin: 
Please select the Organization for which you want to conduct the cycle count by choosing Change 
Organization and then selecting the organization (e.g. WII – WAREHOUSES IN IBADAN) and 
clicking OK. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To define a new cycle 

count. 
Navigate to the Cycle 
Count Summary folder 
window and select New: 
 
Oracle Inventory> 
Counting> Cycle 
Counting> Cycle 
Counts> New 

1.1 Enter a unique name for the cycle count following this 
convention SUBINVENTORY 
CODE_CYCLE_COUNT e.g. 21_CYCLE_COUNT, 
followed by a description (e.g. PPS CYCLE COUNT) 

1.2 Confirm that the IITA workday calendar is the 
Calendar to use for this cycle count. 

1.3 Inventory uses this calendar to determine the days on 
which to automatically schedule cycle counts. 

1.4 Enter the Adjustment Account number against which 
adjustments should be charged.  This account should 
be confirmed from Budget and Finance.  The current 
account for adjustments is 01.8053.1015. 
000000000.0000000.  To enter this account select 
the list of values in the Adjustment Account field 
located on the right side of the field, enter 01 as the 
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company, 8053 as Account, 1015 as Cost Centre, 
000000000 as Reserved and 0000000 as Donors and 
click OK. 

1.5 Save your work 
 

2. To enter control and 
scope information for 
your cycle count. 

Select the Scope and 
Control tabbed region 
(directly below the 
Calendar field). 
 

Enter the Count Controls: 
2.1 Leave the Inactive On field blank 
2.2 Enter 2 in the Late Days field as the number of 

workdays that can pass after the date the count 
request was generated, before a scheduled count 
becomes a late count. 

2.3 Leave the Starting Seq number as 1. 
2.4 Specify that counts can be entered for items not 

scheduled to be counted by checking the 
Unscheduled Entries option. 

2.5 Specify that system on–hand quantities should not be 
displayed during count entry by confirming that the 
Display System Qty option is not checked. 

2.6 Check the Automatic Recounts option to specify that 
Inventory automatically assigns a status of Recount 
to counts containing discrepancies and includes them 
in the next cycle count listing. In the Maximum field 
enter 1 as the maximum number of times Inventory 
can generate an automatic recount request. 

2.7 In the Count Subinventories section, choose the 
Specific option,Navigate to the Subinventory region 
and select the subinventory to include in the cycle 
count from the list of values available in the field. 

2.8 Save your work. 
 

3. To set autoschedule 
information. 

Navigate to the Serial 
and Schedule tabbed 
region. 
 

3.1 Ignore the Serial Control Option section (do not 
change anything, these options are not applicable to 
IITA). 

3.2 Determine whether to automatically schedule this 
cycle count by checking the Auto Schedule option. 

3.3 Frequency: Indicate a Daily schedule for cycle 
counts. Inventory uses this information, along with the 
count frequency of each cycle count class, when 
performing automatic cycle count scheduling. 

3.4 Specify the automatic generation of requests to count 
items with an on–hand quantity of zero be allowed by 
confirming that the Count Zero Quantity option is 
checked 

3.5 Last Date: This field is for information purposes only 
– you cannot change it.  Inventory displays the last 
date this cycle count was automatically scheduled 
(the first time you use this count, this field will be 
blank).  
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3.6 Next Date: Inventory displays the first workday for the 

next schedule interval when this cycle count is 
scheduled. You can enter a later date in this field if 
you want to override the automatic schedule and skip 
one or more intervals. If this field is blank, select the 
next date for the count scheduler to start scheduling 
counts (e.g., to schedule a count for the 3rd of 
September, select this date from the date lookup in 
this field). 

3.7 Save your work 
 

4. To define adjustments 
and ABC information. 

Navigate to the 
Adjustments and ABC 
tabbed region. 
 

4.1 Specify that approval is required for adjustments by 
selecting the Always option in the Required field. 

4.2 Enter ABC initialization information: 
4.3 Group: Enter the ABC group name on which to base 

the cycle count item initialization or update by 
selecting the ABC Group you defined earlier from the 
list of values in the field (e.g. 21_ABC_GROUP-3-
SEP-2001) 

4.4 Option: Choose the (Re)initialise option 
4.5 Attention: If later on you make any modifications to 

the ABC Group Assignment on which the cycle count 
is based (as you when you introduce new items into 
inventory), you would have to redo this process and 
choose the Update option instead.  

4.6 Save your work. 
4.7 Click OK to acknowledge the request submission 

(NB.  You will observe that Option will change back to 
None). 

4.8 To see if the reinitialization process is finished, re–
query the cycle count to see the effects of the 
reinitilization.  You can re-query by selecting Run 
from Query by Example under the View Menu.  You 
should see the word Completed in the status field. 

4.9 Save your work. 
 

5. To define cycle count 
classes. 

Choose the Classes 
button. 
 

5.1 Enter the number of times per year you want to count 
each item in each class: 

5.2 So for A enter 6, for B enter 3, for C enter 1, for D 
and E enter 200.  A class items will be counted 6 
times a year, B class items will be counted 3 times a 
year, C class items will be counted 1 time in the year, 
D and E class items will be scheduled to be counted 
200 times in the year. 

5.3 Do not enter any tolerances/variances (i.e. + or -). 
5.4 Save your work and close the Cycle Count Classes 

window. 
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Generating Cycle Count Requests and Entering Counts  
 
After you have successfully scheduled your counts, you can submit the process to generate count 
requests. Because the count requests are derived from the state of on–hand balances at the time the 
Generate Cycle Count Requests process is run, you should wait to run it until you are ready to count. 
 
This request should be run on a daily basis to enable the daily cycle counts.  Remember to select the 
proper organization for the cycle counting. 
 

TRANSACTION NATURE NAVIGATION TASKS 
6. To submit a request 

set to perform a full 
cycle count and print 
the cycle count listing. 

 

Navigate to Cycle 
Counts Summary folder 
window: 
 
Oracle Inventory> 
Counting> Cycle 
Counting>  
Cycle Counts 

6.1 When you are in the Cycle Counts Summary folder 
window, select Find from the View menu. 

6.2 Select the Cycle Count you want to run and click OK 
6.3 Choose Perform Full Cycle Count from the Tools 

menu. 
6.4 The set includes the following processes and report: 
6.5 Generate automatic schedule requests: Enter 

parameters for cycle count to use (All Cycle Counts – 
No, Cycle Count Name – e.g. 21_CYCLE_COUNT, 
Include Control Items – No) and click OK.  Check the 
Save Output option, and move to the next line with 
the tab key 

6.6 Generate cycle count requests: Enter parameters for 
cycle count to use. (All Cycle Counts – No, Cycle 
Count Name – e.g. 21_CYCLE_COUNT). Click OK. 
Check the Save Output option, and move to the next 
line with the tab key. 

6.7 Cycle count listing: Enter parameters for cycle count 
to use (Cycle Count Name, Start and End Dates, set 
Include Recounts Only to No, select the Subinventory 
to count, set the Display Serial Number option to No, 
leave Display Onhand Quantities as No and Items to 
Include as All). 

6.8 Click OK 
6.9 Check the save output option. 
6.10 To select the printer for the cycle count listing, click 

on the Options button.  Under the Print Output To: 
section, click the list of values in the Printer field and 
select an appropriate printer e.g. MML_HP2100N, 
PPS_PRINTER, etc, and click OK. 

6.11 Enter the number of copies desired e.g. 1 and Click 
OK. 

6.12 Choose Submit. 
6.13 Click OK to acknowledge the request submission. 
 
Use the printed Cycle Count Listing to determine the 
items to count, and to fill in count results.  If the report 
states that no data was found, it means that no counts 
have been scheduled for the day you ran it – try again the 
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next day. 
 
Attention:  Please note that you should run the full cycle 
count every day as the count scheduler has been 
instructed to run Daily. 
 

8. To select the cycle 
count to enter counts 
against. 

Navigate to the Cycle 
Count Entries window 
from the menu: 
 
Oracle Inventory>  
Cycle Counting>  
Cycle Counts>  
Cycle Count Entries 
 

8.1 Enter the name of the cycle count for which to enter 
counts by selecting it from the list of values in the 
Cycle Count field. 

8.2 Enter the date the cycle count was performed. 
8.3 Enter the name of the employee who performed the 

cycle count. 
8.4 Confirm that the general ledger account to which to 

charge adjustments from this cycle count is the 
adjustment account you entered while defining your 
cycle count. 

8.5 Display the count requests you want to enter. You 
can choose the Find button to query all open count 
requests. Answer Yes to the Find all open count 
requests? question. 

 
9. To enter counts. Select the Count tabbed 

region. 
 

9.1 Enter the quantity that you counted for each item by 
using the tab key to move to the Quantity field and 
entering the counted quantities as recorded on the 
printed Cycle Count Listing report. 

9.2 If you happen to see any items on the screens that 
were not included on the report, please ignore them.  
Do not enter any quantities for them. 

9.3 Save your work. 
 

 
Count Adjustments and Approvals 
 
Once you enter and save your cycle counts, Oracle Inventory determines whether any adjustments 
need to be made. 
 
Automatic Recounts 
Inventory automatically submits recount requests for items that would otherwise require adjustment.  
Inventory will submit a recount limited by the maximum automatic recounts you specified for the cycle 
count (in the case of IITA, 1). After you reach the maximum number of recounts, Inventory holds the 
count for approval. Any count request with the Recount status automatically appears on the next 
cycle count listing. 
 
You can also manually request recounts when you are approving adjustments. The count request for 
which you want a recount is also automatically included in the next cycle count listing. 
 
Attention: When generating the cycle count listing, you must include a start date back far enough to 
include the recount’s original count date, or it is not going to be on the report. 
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Approving Cycle Count Adjustments 
Use the Count Adjustment Approvals Summary window to approve cycle count adjustments held for 
approval, to recount an item, or to reject the adjustment. 
 
TRANSACTION NATURE NAVIGATION TASKS 
10. To select the cycle 

count for which to 
approve adjustments. 

Navigate to the Count 
Adjustment Approvals 
Summary window: 
 
Oracle Inventory> 
Counting> Cycle 
Counting> Approve 
Counts 
 

10.1 Enter the name of the cycle count for which to 
approve counts. 

10.2 Select the Find button to query records. Select No to 
view all cycle count entries. 

10.3 Note the items that are flagged in the Recount option 
and ask for the items to be recounted/investigated. 

 

11. To recount items  (if 
required) 

 11.1 Use the request set to perform a Full Cycle Count 
again and print the Cycle Count Listing, making sure 
that the Include Recounts Only option in the Cycle 
Count Listing parameters is set to Yes. 

11.2 Use the Cycle Count Listing report to go back and 
count the items flagged for recounting. 

11.3 Enter the new counts in Cycle Count Entries window 
(even if the count is the same as before, you must re-
enter it).  

11.4 Save your work. 
 

12. To finally approve 
adjustments. 

Navigate to the Count 
Adjustment Approvals 
Summary window: 
 
Oracle Inventory> 
Counting> Cycle 
Counting> Approve 
Counts 
 

12.1 Enter the name of the cycle count for which to 
approve counts. 

12.2 Select the Find button to query records. Select No to 
view all cycle count entries. 

12.3 Change any items with a status of None to Approved 
12.4 Save your work. 
12.5 Click OK to acknowledge the processed adjustments. 
 

 
Purging Cycle Count Information 
This should be done at the end of the year after the last cycle count in preparation for the definition of 
the next years cycle counts. 
 
 NAVIGATION TASKS 
13. To purge cycle count 

information. 
Navigate to Cycle 
Counts Summary folder 
window: 
 
Oracle Inventory>  
Counting> 
Cycle Counting> 
 Cycle Counts 

13.1 When you are in the Cycle Counts Summary folder 
window, select Find from the View menu. 

13.2 Choose Purge Cycle Count from the Tools menu. 
The Purge Cycle Count Parameters window appears. 

13.3 Indicate whether this is a full cycle count purge 
including the header, cycle count items, schedule 
requests, and count requests by leaving the History 
Only option unchecked, or that this is a historical 
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 cycle count purge of schedule requests and count 

requests on or before the historical purge date by 
checking the History Only option. 

13.4 Enter the date for the purge. Oracle Inventory deletes 
schedule requests and count requests on or before 
this date. 

13.5 Choose OK to submit the request. 
13.6 Click OK to acknowledge the request submission. 
 

 
Cycle Count Reports 
 
You can use a number of reports to help you during the process of cycle counting and to analyze and 
report the results of cycle count transactions. You can submit a concurrent request for these reports 
from the Tools menu in most of the cycle counting windows as well as from the Submit Requests 
window. 
 
Cycle Count Schedule Requests Report This report shows all schedule requests for a specified 
time period. It includes both manually and automatically scheduled items. 
 
Cycle Count Listing This report lists all of the items currently due for cycle counting, including their 
revision, lot number, subinventory and locator information. You can use this report as the document 
you give to the employees performing the cycle counts. Since the report leaves a blank line for the 
counter’s name, the count date, and the actual count quantity, the counter can use this listing to write 
down and report his cycle count results. 
 
Cycle Count Open Requests Listing This report shows count requests where no counts have been 
entered, or count entries where you have requested a recount. You can optionally report on late 
counts, where no counts have been entered and the due date for the count entry is before the date of 
the report. 
 
Cycle Count Unscheduled Items Report This report shows those items that are currently not 
scheduled to be counted and were last scheduled a period of time in the past that is longer than 
expected, as dictated by the count frequency of the class to which the item belongs. For example, if 
item XYZ belongs to class A, and you count class A 52 times a year, you would expect item XYZ to 
be scheduled once a week. If item XYZ was last scheduled two weeks before the date you run the 
Cycle Count Unscheduled Items Report, it appears on the report. 
 
You primarily use this report as an auditing tool. If you correctly set up your scheduling and counting, 
and are always current in your count, Oracle Inventory should not find any unscheduled items to 
report. However, if you do not run the auto scheduler as frequently as it needs to run, or if concurrent 
manager problems prevent its execution, you may fall behind in your count schedules. 
 
Cycle Counts Pending Approval Report This report shows those counts that were entered and are 
currently pending approval. The supervisor with the authority to approve cycle count adjustments 
would typically run this report regularly to monitor the approval queue. 
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Cycle Count Entries and Adjustments Report This report shows all cycle count entries for a 
specified time period. It analyzes the number of cycle count transactions you make against an item, 
and the number of units you actually adjust. The report also calculates the value, in your functional 
currency, of the adjustments to inventory. 
 
Cycle Count Hit/Miss Analysis This report shows, for each cycle count class, the total number of 
count entries and the number of counts outside the limits of the user–specified hit/miss tolerances. 
The report also calculates the overall accuracy percentages broken down by cycle count class and 
subinventory. This report is based on the first count only, not recounts. 
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Viewing Material Transactions 
 
You can view detail associated with inventory transactions. You can search for transaction 
information by entering a combination of criteria. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To view detail 

associated with 
inventory transactions. 

 
Note: Use Change 
Organization to select the 
proper organization for 
which you want to view 
Material Transactions (e.g. 
WII - WAREHOUSES IN 
IBADAN) before selecting 
the Material Transactions 
window. 
 

Navigate to the Material 
Transactions folder 
window: 
 
Oracle Inventory> 
Transactions> Material 
Transactions 
 
The Find Material 
Transactions window 
appears.  
 

1.1 Enter any combination of search criteria.  The system 
chooses today’s date for the transaction date range – 
you change this if desired. After entering all the 
desired criteria, choose Find. The results display in 
the Material Transactions folder window. 

 
View information in the following tabbed regions: 
1.2 Location: Displays the item, subinventory, locator, 

revision, transfer locator, transfer subinventory, 
transfer organization, transaction date, and 
transaction type information. 

1.3 Intransit: Displays the item, shipment number, 
waybill/airbill number, freight code, container, 
quantity, and transaction type information. 

1.4 Reason, Reference: Displays the item, transaction 
reason, transaction reference, costed indicator, 
supplier lot, source code, source line ID, and 
transaction type information. 

1.5 Transaction ID: Displays the item, transfer transaction 
ID, transaction header number, receiving transaction 
ID, move transaction ID, transaction UOM, 
completion transaction ID, department code, 
operation sequence number, transaction quantity, 
transaction ID, transaction date, source type, source, 
transaction type, source project number, source task 
number, project number, task number, to project 
number, to task number, expenditure type, 
expenditure organization, error code, and error 
explanation information. 

1.6 Transaction Type: Displays the item, source, source 
type, transaction type, transaction action, transaction 
UOM, transaction quantity, transaction ID, and 
transaction date information. 

 
2. To view lot/serial 

number information for 
a transaction 

Select a transaction and 
choose the Lot/Serial 
button. 

2.1 View information on lot/serial numbers, quantities, 
and locations. 
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Viewing Transaction Summaries 
 
You can view transaction summaries for items transacted within a specified date range. You can use search 
criteria to further narrow the focus of the information summarized. You can use this information for input/output 
and transaction history analysis (for example to trace all the transactions involving a specific item so as to help in 
investigation of discrepancies). 
 

TRANSACTION NATURE NAVIGATION TASKS 
1. To view transaction 

summaries.  
 
Note: Use Change 
Organization to select the 
proper organization for the 
transaction summaries 
(e.g. WII - WAREHOUSES 
IN IBADAN) before 
selecting the Summarize 
Transactions window. 

Navigate to the 
Summarize 
Transactions window: 
 
Oracle Inventory> 
Transactions> Viewing 
Transaction Summaries 
 

1.1 Enter the date range to summarize (the system 
displays today’s date by default, you can change 
this).  

1.2 Enter an item or a subinventory. If you do not enter an item, 

the search includes all items with transactions falling within 

the date range specified. 

1.3 Optionally, enter additional search criteria to narrow 
the focus of the summarized information. 

1.4 Choose the Summarize button. The results appear in 
the Item Transaction Summaries window. Values 
displayed for each item include the unit of measure, 
net quantity, net value, volume (number of 
transactions), absolute quantity, and absolute value. 
Transaction totals include total value in, total volume 
in, total value out, total volume out, and net value.  
These values are for the date range you specified. 

1.5 Select from the different tabbed regions to view the 
summary information by Items Only, Source Type, 
Action, Transaction Type, and Source/Transaction 
Type. 

 
2. To view detail 

information for an item 
in the Item Transaction 
Summaries window. 

Select an item. 
 

2.1 Choose the Transaction Details button. 
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Material Transaction Distributions 
 
View inventory accounting distributions. View account, currency, location, and transaction type 
information for transactions performed within a date range.   
 
Material distributions can be seen for the period when the system costing processes have been 
completed. 
 

TRANSACTION NATURE NAVIGATION TASKS 
1. To view inventory 

transaction 
distributions 

 
Note: Use Change 
Organization to select the 
proper organization for 
which you want to view 
material transaction 
distributions (e.g. WII - 
WAREHOUSES IN 
IBADAN) before selecting 
the Material Transaction 
Distributions window. 
 

Navigate to the Material 
Transaction 
Distributions window: 
 
Oracle Inventory> 
Transactions>  
Material Distributions  
 
The Find Material 
Transaction 
Distributions window 
appears. 
 

1.1 Enter the required search criteria.  The Material 
Transactions Distributions window displays 
transaction dates and five tabbed regions: Account, 
Location, Type, Currency, and Comments. 

1.2 Account: Displays the account, transaction value, 
item, revision, and the accounting type. 

1.3 Location: Displays the subinventory, locator, 
operation sequence, and transaction ID. 

1.4 Type: Displays the transaction type (such as 
miscellaneous issue, sales order issue, or cycle count 
adjustment), source type (the origin of the inventory 
transaction), source (such as account number), the 
UOM, and the primary quantity (in the item’s primary 
UOM). 

1.5 Currency: Displays currency, the transaction value 
(for foreign currency), and displays the conversion 
(exchange) rate, type (such as Spot, Corporate, or 
User Defined), and exchange rate date. 

1.6 Comments: Displays transaction reason, transaction 
reference, and the general ledger batch ID (if 
transferred to the general ledger). 
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Viewing Pending Transactions 
 
You should view pending transactions if any of the normal inventory/purchasing transaction does not 
seem to produce the desired results – the transactions may be stuck in the pending transactions 
table. 
 
This table also includes transactions received through the transaction interface or 
those processed with the background processing option. Using the folder or single row windows, you can 
choose how to view the information appropriate for a particular transaction. You can also resubmit transactions 
for processing. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To view pending 

transactions. 
 
Note: Use Change 
Organization to select the 
proper organization for 
which you want to view 
pending transactions (e.g. 
WII - WAREHOUSES IN 
IBADAN) before selecting 
the Pending Transactions 
folder window. 
 

Navigate to the Pending 
Transactions folder 
window: 
 
Inventory>Transaction>
Pending Transactions 
 
The Find Pending 

Transactions window 

appears. 
 

1.1 Enter search criteria for the pending transactions you 
want to view.  You can search for transactions based 
on processing information, source, or item details. 

1.2 Choose Find to start the search. The results display 
in the Pending Transactions window. 

 
Select a tabbed region to display a type of information: 
1.3 Error: Pending transaction error information. 
1.4 Location: Pending transaction location information. 
1.5 Source: Pending source information 
1.6 Intransit: Pending intransit shipping information. 
1.7 Others: Miscellaneous header and costing 

information. 
 

2. To resubmit 
transactions to the 
demand manager for 
processing. 

Pending Transactions 
folder window. 

2.1 Check the Submit option next to the transactions you 
want to resubmit or choose Resubmit All from the 
Tools menu.  If you have many transactions to 
resubmit, use the Resubmit All option to select all 
transactions for processing and then selectively 
deselect individual transaction you do not want to 
resubmit. 

2.2 Save your work to submit the transactions for 
processing. 

 
3. Running the Material 

Transaction manager. 
 
Note: If the transaction-
processing mode for the 
lines is set to Background, 
you will have to run the 
material transaction 
processor. 

Navigate to the 
Interface Managers 
window: 
 
Oracle Inventory> 
Setup> Transactions>  
Interface Managers 
 

3.1 Select the Material Transaction line 
3.2 Select Launch Manager from the Tools menu 
3.3 Click on the Submit button in the Launch Inventory 

Managers window 
3.4 Click OK to acknowledge the request submission 
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Maintaining Item Lot Information 
 
You can update the disable status and expiration date associated with item lot information.  You can 
also determine which item lots have expired and then decide what to do with any on-hand quantity 
you may have.   You should only disable lots that have no on-hand quantity. 
 
It is recommended that expired items should be disposed of and the on-hand quantity (and hence the value in 
the budget) be eliminated via a disposal material transaction.  Alternatively, the actual material should be 
checked and if it is confirmed that it is okay for use, the expiry date can be updated. 
 
The Pick Release process in MRI processing will choose items from the lots that will expire first. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To display item lot 

information. 
 
Note: Use Change 
Organization to select the 
proper organization for 
which you want to 
manage the lot 
information (e.g. WII - 
WAREHOUSES IN 
IBADAN). 
 

Navigate to the Item 
Lots window: 
 
Oracle Inventory> 
On-hand, 
Availability> Lots 
 
The Find Lots window 

appears. 
  

1.1 Enter search criteria.  
For example, to see all the enabled lots that 
have expired on or before the 30-SEP-2001, 
you could enter 30-SEP-2001 in the second 
Expiration Date field (leaving the first blank), 
and select Enabled Only in the Disabled Lots 
field. 
If you do not enter criteria, a query for all lots is 
performed. 

1.2 Choose the Find button to display the lot and 
item information in the Item Lots window. 

 
2. To update expiration 

date and disable 
status information 

Item Lots window. 2.1 Enter an expiration date. 
2.2 Indicate whether the lot is disabled (by checking 

the Disabled option) or not (by unchecking it). 
2.3 Save your work. 
 

3. To view supplier lot 
information. 

Choose the Supplier 
Lot button.  
 
 

3.1 The Supplier Lots window appears.  You may or may 
not see anything here. 

4. To view material 
transactions for an 
item lot. 

Select an item and 
lot. 
 

4.1 Choose the Transactions button.  
. 
 

5. To view on–hand 
availability for an 
item lot. 

Select an item and 
lot. 
. 

5.1 Choose the On–hand button. The Find On–
hand Quantities window appears. 
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Unit of Measure Classes, Measures and Conversions 
 
Unit of measure classes represent groups of units of measure with similar characteristics. Creating 
unit of measure classes is the first step in unit of measure management. Each unit of measure you 
define must belong to a unit of measure class. 
 
Each class has a base unit of measure. The base unit of measure is used to perform conversions 
between units of measure in the class. For this reason, the base unit of measure should be 
representative of the other units of measure in the class, and generally one of the smaller units. For 
example, you could use LT (Litre) as the base unit of a class called Volume. 
 
Units of measure are used by a variety of functions and transactions to express the quantity of items. 
Defining units of measure is the second step in unit of measure management. The values defined in 
the Units of Measure window provide the list of values available in unit of measure fields in other 
windows. 
 
The primary unit of measure is the stocking unit of measure for an item in a particular organization. 
The primary unit of measure is an item attribute that you specify when defining each item. 
 
Unit of measure conversions are numerical factors that enable you to perform transactions in units 
other than the primary unit of the item being transacted. You can define: 
� a conversion common to any item (Standard) 
� a conversion for a specific item within a unit of measure class (Intra–class) 
� a conversion for a specific item between unit of measure classes (Inter–class) 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To define a unit of 

measure class. 
Navigate to the Unit of 
Measure Classes 
window. 
Oracle Inventory> 
Setup> Units of 
Measure> Classes  
 
If prompted by the 
system for an 
organization, select any 
one – units of measure 
are not dependent on 
any organization. 

1.1 Select New from the File menu to create a new class. 
1.2 Enter a unique name for the unit of measure class 

(i.e. a class name that has not been used before, e.g. 
WGT) and a description for this class (e.g. WEIGHT). 

1.3 Define the base unit of measure for this class (e.g. 
KILOGRAM). 

1.4 Define a unique abbreviation for the base unit of 
measure (e.g. KG). 

1.5 Save your work. 

2. To define a unit of 
measure. 

If prompted by the system 
for an organization, select 
any one – units of 
measure are 
organization 
independent. 

Navigate to the Units of 
Measure window: 
 
Oracle Inventory> 
Setup>  
Units of Measure>  
Units of Measure 
 

2.1 Select New from the File menu to create a new unit of 
measure 

2.2 Enter a unique name for the unit of measure. 
2.3 Enter a unique abbreviation for the unit of measure 

using two characters. 
2.4 For example, EA for each or HR for hour. 
2.5 Enter or select a unit of measure class from the list of 

values available by clicking the list of values button to 



 

 52
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 the right of the Class field. 

2.6 Indicate if this is the base unit of measure for the unit 
of measure class by checking the Base Unit column 
check box beside the Class column. 

2.7 Save your work. 
 

3. To define a Standard 
conversion for all 
items. 

Navigate to the Unit of 
Measure Conversions 
window: 
 
Oracle Inventory> 
Setup>  
Units of Measure> 
Conversions 

3.1 Select the Standard tabbed region. 
3.2 Select Find from the View menu. 
3.3 Select the UOM for which you want to define a 

conversion and click OK 
3.4 Enter the conversion factor by which the unit of 

measure is equivalent to the base unit of measure 
established for this class. For example, if one DZ (this 
unit of measure) is equivalent to 12 EA (base unit), 
the conversion factor is 12. Or, if EA is equal to one–
twelfth of a DZ, the conversion factor is 0.08333.  

3.5 Save your work. 
 
Please see the list of IITA UOM classes and codes for the 
existing definitions. 
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Defining Subinventories 
 
Subinventories are unique physical or logical separations of material inventory, such as raw 
inventory, finished goods, or defective material.  All material within an organization is held in a 
subinventory therefore, you must define at least one subinventory.  Subinventories in most cases 
correspond to warehouses or stores. 
 
Please see the IITA Subinventory List for a complete list of the defined subinventories. 
 

TRANSACTION NATURE NAVIGATION TASKS 
1. To define subinventory 

header information.  
 
Note: Please use the 
Change Organization 
function to select the 
proper organization for the 
subinventory (e.g. WII - 
WAREHOUSES IN 
IBADAN) before selecting 
the Subinventories 
Summary folder window. 

Navigate to the 
Subinventories 
Summary folder 
window: 
 
Oracle Inventory> 
Setup> Organizations> 
Subinventories 
 

1.1 Choose New. The Subinventories window appears. 
1.2 Enter a unique name, which should be a 2 digit 

number  (e.g. 11) Enter a description for the 
subinventory, which should be the actual name of the 
subinventory  (e.g. CENTRAL STORES) 

 

2. To define parameters, 
lead times, and 
sourcing information. 

Subinventories 
Summary folder 
window. 
 
Select the Main tabbed 
region (below the 
description field). 
 

2.1 Confirm that the Quantity Tracked option is checked 
(with a black check mark) to indicate that each 
transaction for this subinventory updates the quantity 
on hand for the subinventory. 

2.2 If you uncheck this option, a record of on–hand 
balances is not maintained.  You can update this 
value only if there is no on–hand quantity for the 
subinventory. 

2.3 Confirm that the Asset Subinventory option is 
checked to indicate that the value of the subinventory 
is maintained on the IITA balance sheet.  You can 
update this value only if there is no on–hand quantity 
for the subinventory. 

2.4 Leave the Include in ATP option checked (not 
applicable to IITA) 

2.5 Confirm that the Allow Reservation option is checked 
to indicate whether to include this subinventory in 
available–to–reserve calculations. 

2.6 Confirm that the Nettable option is checked to 
indicate that the planning process uses the on–hand 
balance of these subinventory items as available to 
IITA 
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2.7 Select a type of locator control. You can only 

update this option if there is no on–hand 
quantity for the subinventory. 
� None: Inventory transactions within this 

subinventory do not require locator information.  
This option is not currently used in IITA 

� Prespecified: Inventory transactions within this 
subinventory require you to enter a valid 
predefined locator for each item (the stock locator 
must have been defined before any transaction for 
the location.  Prespecified is the option used in 
IITA). 

� Dynamic entry and Item level: Not used in IITA 
2.8 Enter an optional picking order value if required.  This 

option is currently not used in IITA. 
2.9 Optionally, enter an inactive date for the subinventory 

from which transactions can no longer be performed.  
This option is not used in IITA. 

2.10 Pre–processing, processing, and post–processing 
lead times are not currently used in IITA – they 
should be left blank. 

2.11 Select a Source type for item replenishment. 
� Inventory: Replenish items internally, from another 

organization. 
� Supplier: Replenish items externally, from a 

supplier (this is the option currently used for most 
subinventories in Ibadan).  Only the Supplier 
option should be used in IITA. 

� Subinventory: Replenish items internally, from 
another subinventory in the same inventory 
organization. 

2.12 If you entered Inventory in the type field select the 
organization used to replenish items in this 
subinventory. 

2.13 If you entered your current organization in the 
Organization field, or you selected Subinventory in 
the type field select the subinventory used to 
replenish items in this subinventory. 
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3. To define subinventory 

account information. 
Subinventories 
Summary folder 
window. 

3.1 Enter the general ledger accounts. The default 
accounts are those defined for the organization in the 
Organization Parameters window (i.e. Material, 
Outside Processing, Material Overhead, Overhead 
and Resource).  They cannot be changed. 
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Defining Stock Locators 
 
You use locators to identify physical areas where you store inventory items.  Item quantities can be 
tracked by locator.  Items can also be restricted to specific locators if required.  Currently, no item is 
restricted to any locator in IITA. 
 
A general coding structure consisting of the subinventory code, a defined area within the store, rack 
number, shelf level and bay number should be used. 
 
As an example, take the locator code 21A-06C-01.  In this code, 21 is the subinventory code, A is the 
defined area within the warehouse, 06 is the rack number, C is the shelf level lettered from bottom 
up, starting with A) and 01 is the bay number. Thus the location code above represents the following 
location:   
 
21 = PPS STORE 
A  =  Ground Floor 
06  =  Rack Number 06 
C  =  Third Shelf Up 
01 =  Bay Number 01 
 
Stock locators must be unique within the system. 
 
Please note that only the required level of detail should be used in any case i.e. if the location is just 
a defined area in the warehouse/store (no shelf or otherwise), no more than the subinventory code 
and area code (e.g. 21-A) need be used. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To define required 

information for a 
locator. 

 
Note: Use Change 
Organization to select the 
proper organization for the 
subinventory to have 
locators defined (e.g. WII - 
WAREHOUSES IN 
IBADAN) before selecting 
the Subinventories 
Summary folder window. 

Navigate to the 
Subinventories 
Summary folder 
window: 
 
Oracle Inventory> 
Setup> Organizations> 
Subinventories 
 

1.1 When you are in the Subinventories Summary folder 
window, select Find from the View menu. 

1.2 Select the subinventory for which you want to define 
stock locators and click OK 

1.3 Click on the Locators button at the bottom of the 
Subinventories Summary folder window 

1.4 Choose the Parameters tabbed region. 
1.5 Enter the locator and its description. (e.g. 21A-06C-

01 with a description AUTOMOTIVE PARTS) 
1.6 Picking order is not required and is currently not in 

use in IITA 
1.7 Save your work 
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Defining Freight Carriers 
 
A freight carrier represents a commercial company or any other means used for internal transfers 
between organizations, as well as shipments to and from customers and suppliers. You must 
associate a general ledger account with each carrier to collect costs associated with using this 
carrier. You assign a carrier to each inter–organization transaction.  
 
This assignment of carriers is very important in tracking the cost of transferring items from one 
inventory organization (e.g. Ibadan) to another (e.g. Onne) or from suppliers to IITA. 
 

TRANSACTION NATURE NAVIGATION TASKS 
1. To define a freight 

carrier. 
 
Note: Use Change 
Organization to select the 
proper organization for the 
freight carriers (e.g. WII - 
WAREHOUSES IN 
IBADAN) before selecting 
the Freight Carriers 
window. 

Navigate to the Freight 
Carriers window: 
 
Oracle Inventory> 
Setup> Freight Carriers 

1.1 Enter a unique name for the freight carrier (a name 
that has not been used for a freight carrier in the 
organization before) and a description (e.g. IITA 
TRUCK with the description IITA TRUCK FOR LONG 
DISTANCE TRANPORTATION). 

1.2 Choose the general ledger distribution account 
that collects the costs associated with using this 
carrier confirm the account code from Budget 
and Finance.  The current code in use is 
01.9908.1015.000000000.0000000, select the 
list of values under the Distribution Account field 
located on the right side of the field, enter 01 as 
the company, 9908 as Account, 1015 as Cost 
Centre, 000000000 as Reserved and 0000000 
as Donors and click OK. 
Note: The account will be the same for all 
Freight Carriers you define. 

1.3 Save your work. 
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Defining Account Aliases 
 
An account alias is an easily recognized name or label representing a general ledger account e.g. 
INSURANCE_ACCOUNT to represent an account code such as 01.1531.0000.000000000.0000000.  
 
During a transaction in the Miscellaneous Transaction screen (Oracle Inventory), you can use the 
account alias instead of an account code to refer to an account combination. 
 
TRANSACTION NATURE NAVIGATION TASKS 
1. To define an account 

alias. 
 
Note: Use Change 
Organization to select the 
proper organization for the 
account aliases (e.g. WII - 
WAREHOUSES IN 
IBADAN) before selecting 
the Account Aliases 
window. 

Navigate to the Account 
Aliases window: 
 
Oracle Inventory> 
Setup> Account 
Aliases. 

1.1 Enter a unique account alias name derived from the 
IITA general ledger account code description e.g. 
INSURANCE_ACCOUNT. 

1.2 Enter a description for the alias. 
1.3 Enter the general ledger account to which you charge 

all transactions that use this account alias 
1.4 For example if the account is 

01.1531.0000.000000000.0000000, select the list of 
values under the Account field located on the right 
side of the field, enter 01 as the company, 6784 as 
Account, 1015 as Cost Centre, 000000000 as 
Reserved and 0000000 as Donors and click OK. 

1.5 Enter the effective date on which the account alias is 
enabled and can be used. This date must be greater 
than or equal to the current date (today’s date). 

1.6 Save your work. 
 

 
Please refer to the IITA Account Alias list for existing account aliases. 
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